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  Important Notice 

Important Notice 
This guide is subject to the following conditions and restrictions: 

This User's Guide provides documentation for the PowerTerm® Series of 
products. Your specific PowerTerm WTC product might include only a portion 
of the features documented in this Guide. 

The proprietary information belonging to Ericom® Software is supplied 
solely for the purpose of assisting explicitly and properly authorized users of 
PowerTerm®. 

No part of its contents may be used for any other purpose, disclosed to any 
person or firm, or reproduced by any means, electronic and mechanical, 
without the express prior written permission of Ericom® Software. 

The text and graphics are for the purpose of illustration and reference only. 
The specifications on which they are based are subject to change without 
notice. 

The software described in this document is furnished under a license 
agreement. The software may be used or copied only in accordance with the 
terms of that agreement. 

Information in this document is subject to change without notice. Corporate 
and individual names and data used in examples herein are fictitious unless 
otherwise noted. 

 

Copyright© 1994 – 2005 Ericom® Software 

Ericom® and PowerTerm® are registered trademarks of Ericom® Software, 
which may be registered in certain jurisdictions. Other company and brand, 
product and service names are trademarks or registered trademarks of their 
respective holders. 
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  About this Guide 

About this Guide 
PowerTerm WTC is a fully functional terminal emulator for Microsoft 
Windows XP Embedded (XPe) operating platforms. 

This Guide assumes that you are familiar with basic windowing system 
conventions (file transferring, copy/paste functions, etc.) and the operation 
of the terminal you intend to emulate. 

The PowerTerm WTC User's Guide is comprised of the following chapters: 

Chp.  1 Introduction Presents 
PowerTerm 
WTC and its 
main features. 
It also 
describes how 
to get 
PowerTerm 
WTC started. 

Pg. 8

Chp.  2 PowerTerm 
WTC: General 
Reference

Describes the 
PowerTerm 
WTC Window, 
the menus 
and the 
different 
dialogs. 

Pg. 14

Chp.  3 Starting and 
Stopping 
Sessions

Describes how 
you start and 
stop sessions, 
and customize 
them. 

Pg. 68

Chp.  4 Defining 
Emulations

Describes how 
to configure 
and customize 
emulations 
parameters.  

Pg. 73

Chp.  5 Defining 
Connections

Describes how 
to configure 
connections 
and save 
them. 

Pg. 76

Chp.  6 Manipulating 
the Desktop 
and Selecting 
Text

Explains how 
you can 
customize the 
Desktop 

Pg. 80
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display and 
how to select 
text in 
different ways. 

Chp.  7 Keyboard 
Settings

Describes how 
to customize 
and map your 
keyboard. 

Pg. 87

Chp.  8 Soft Buttons 
and Power Pad

Explains how 
to customize 
Soft Buttons 
and the Power 
Pad. 

Pg. 93  

Chp.  9 Printing Explains how 
to define 
printing 
parameters. 

Pg. 95

Chp.  10 Scripts Explains how 
to work with 
the 
PowerTerm 
Scrip 
Language 
(PSL). 

Pg. 99

Chp.  11 Session 
Manager

Describes the 
Session 
Manager and 
how to use it. 

Pg. 
102

Chp.  12 PowerTerm 
WTC FTP Client

Describes the 
FTP client and 
explains how 
to use it. 

Pg. 
103
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  Introduction 

1 Introduction 
This chapter presents PowerTerm WTC and its main features. It also 
describes the basic steps on how to use PowerTerm WTC for users who are 
familiar with accessing remote terminals.  

This chapter includes the following topics: 

• What is PowerTerm WTC? 

• PowerTerm WTC Features 

• System Requirements 

• Getting Started 

1.1 What is PowerTerm WTC? 
PowerTerm WTC is a fully functional emulator for Microsoft Windows Thin 
Client operating systems. It emulates various terminal types, including IBM, 
UNIX, HP, VMS and Tandem. PowerTerm WTC enables you to connect to a 
single or to multiple hosts via both network and remote connections.  

PowerTerm WTC has two main features to enable the WTC to act and feel 
like a real host terminal: 

• Terminal display emulation, PowerTerm WTC emulates the exact display of the 
chosen terminal. It presents host applications precisely as they would 
appear on the terminal. Once the WTC connects to a host computer, all host 
operations can be performed as if the WTC is an actual host terminal. 

• Terminal keyboard emulation, PowerTerm WTC enables you to emulate the 
selected terminal's keyboard by mapping the WTC keys to match the host 
keys. Keyboard mapping definitions are stored in a .ptk file. 

PowerTerm WTC also provides various options to customize and optimize the 
working environment such as: 

• Power Pad, a programmable floating keypad. 

• Soft buttons, programmable buttons located at the bottom of the PowerTerm 
WTC window. 

• PowerTerm Script Language (PSL), a full-featured programming language, 
which enables you to create scripts for automating tasks. For example, you 
can create a PSL script for automatic login. Scripts can be used at start up of 
PowerTerm WTC, or can be utilized any time during a PowerTerm WTC 
session. PSL commands can also be assigned to the Soft buttons and the 
Power Pad to enable additional functions with a click of the mouse. 

PowerTerm WTC enables you to use the standard Microsoft DDE mechanism 
to communicate with other Windows applications as DDE client or DDE 
server application. 

8 of 127 



  Introduction 

1.2 PowerTerm WTC Features 
PowerTerm WTC features include: 

• Compact, light and high performance program 

• 32-bit support for Windows NT/XP embedded 

• File transfer for Xmode, Ymodem, Zmodem, Kermit, Ascii, Binary, and 
IND$FILE 

• Supports TCP/IP WinSock, DECnet (CTERM), and LAT 

• Supports RS-232 (both direct and via modem), PPP/SLIP, SNA, and APPC 
connections 

• Supports Ethernet and Token ring networks. 

• PowerTerm Script Language (PSL) 

• String functions, including sub-string, index and concatenation 

• Enables you to save parameters for all sessions 

• High-level API enables access from other environments, such as C++, Visual 
Basic, and Power Builder. Also supports EHLLAPI. 

• Session Manager 

• Language support for most Western and Eastern European languages 

• Modem dialing 

• Multi-session capabilities 

• User programmable Soft buttons 

• Floating Power Pad with programmable buttons 

• Control of color selection and screen attributes 

• Supports printing including Auto Print mode and Slave Printing. Also 
supports Advanced Printing capabilities, including TN5250 Host Print 
Transform, specifying the orientation of the printed output for non-graphic 
printing, setting values for CPI/LPI/FONT parameters, printer rows and 
columns. 

• Supports Kermit get command 

• Easy to use keyboard mapping 

• DDE communication for client or server 

• Supports PowerTerm RemoteView 

1.3 Getting Started 
1.3.1 PowerTerm WTC Setup 

To enable WTC-host interactions, you need to define two sets of parameters: 

• Terminal parameters 
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• Communication parameters 

All parameters are saved in a Terminal setup file where the default is called 
ptdef.pts. Setup file extensions are: 

• pts for the Terminal setup file 

• ptc for the Communication setup file 

• ptk for the Keyboard definitions file 

• ptp for the Power Pad definitions file 

PowerTerm WTC provides the option to work with a single host or with 
multiple hosts. You can create different setup configurations for working with 
each host to enable each user a customized working environment. (For more 
information about specifying and saving parameters, see chapters Defining 
Emulations and Defining Connections.) 

Working with a Single Terminal Connection 
If you only need to connect to a single host connection, you should use the 
default terminal setup and communication file. PowerTerm WTC 
automatically uses the parameters in the setup file to start the system. 

Working with Multiple Terminal Connections 
If you are working with multiple terminal connections, you may need to use 
a different setup file for each emulation. To create a setup file, you first need 
to define the terminal setup and communication parameters, and then save 
these parameters to a terminal setup file. 
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1.3.2 A Quick Guide through PowerTerm WTC 

 

Step 1: Start PowerTerm WTC 
Click the PowerTerm WTC icon on the desktop. The PowerTerm WTC window 
opens. 

 When PowerTerm WTC is used for the first time, the PowerTerm WTC 
window is automatically displayed together with the Connect dialog. After 
the connection parameters have been defined, the Connect dialog will be 
displayed according to your selected option. 

PowerTerm WTC opens with the default terminal setup file. You can also 
open PowerTerm WTC using a customized setup file, or script. 

The most important feature of the PowerTerm WTC window is its work area, 
which emulates a host terminal screen by displaying data entered on your 
terminal data received from the host. (For more information on how to 
customize your desktop, see chapter Manipulating the Desktop and Selecting 
Text) 

Step 2: Select a Terminal Emulation 
You can either select a terminal for the current session or open a previously 
defined terminal setup file. 
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 To select terminal settings: 

1. Select Terminal | Setup. The Terminal Setup dialog appears. 

2. Select the Emulation tab. 

3. Click one of the Terminal Types. The emulation type that you select changes 
the number of setup tabs and, for IBM emulations, the PowerTerm WTC 
windows display. 

4. Define terminal settings by clicking the relevant Property page tab and define 
setup parameters. 

5. Click OK. 

6. Save the settings by selecting File | Save Terminal Setup or Save Terminal 
Setup As. The file is saved. 

 To open a previously defined Terminal setup file: 

1. Select File | Open Terminal Setup. The Open File dialog appears. 

2. Select your desired setup file and click OK. 

Or, 

1. Select Communication | Connect. The Connect dialog appears. 

2. Click the setup browse button. The Setup dialog appears. 

3. Type your desired setup file name or alternatively click the browse button 
and select the desired file in the Browse Terminal Setup dialog. 

Step 3: Connect to Host 
After you have selected a terminal emulation, you need to define 
communication parameters for the current session, or select a previously 
saved session from the Session List. 

 To connect to a host: 

1. Select Communication | Connect. The Connect dialog appears. 

2. Define communication parameters or select a session with previously defined 
connection parameters from the Session list. 

3. Click Connect. A connection is established to a host computer. 

Step 4: Work with the Host 
Once you have connected to a host, PowerTerm WTC enables you to work as 
if you are working from a terminal. 

PowerTerm WTC enables you to transfer files to and from a host as well as 
define print parameters, and print the terminal screen or data transferred 
from the host application. 
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Step 5: Exit PowerTerm WTC 
PowerTerm WTC provides different options when exiting PowerTerm WTC. 
You can end a session automatically or be prompted with a confirmation 
message prior to closing a session. 

• Select File | Exit or press both <Alt> and <X> on the keyboard. 
If you have changed terminal settings, PowerTerm WTC displays a warning 
message asking if you want to update the terminal settings file. The 
message will point to the name of the setup file currently loaded (ptdef.pts, 
if you use the default settings). Click OK to update the terminal settings, or 
No to cancel the latest changes and restore the default setup. 
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2 PowerTerm WTC: General Reference 

2.1 The PowerTerm WTC Window 

 

The following is a list of the PowerTerm WTC window components as they 
appear from top to bottom. You can configure all the components, except 
the work area, to be displayed or hidden as will be convenient for you. 

 

Control Menu Box Provides standard Windows 
commands and enables you to 
redisplay the Menu bar. 

Title Bar Displays the application name. 
During a communication 
session, the ID type and/or host 
name is displayed next to the 
application name, for example, 
(A) PowerTerm WTC. 

Minimize button Closes the window, but not 
PowerTerm WTC. 

• Click the PowerTerm WTC icon 
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appearing in the Taskbar to 
reopen the PowerTerm WTC 
window. 

Maximize button Enlarges the window so that if 
fills the entire screen. The 
button is then replaced with the 
Restore button. This button is 
used to restore the window to 
its previous size. 

Close button Closes the application. 

Menu Bar Contains dropdown menus, 
which enable the user to 
perform most PowerTerm WTC 
operations. 

Toolbar Contains icons, which can be 
used as shortcuts to access 
frequently used menu 
commands. 

Work Area Displays the data entered to the 
WTC terminal or received from 
the host. During an emulation 
session, this work area 
emulates a terminal display. For 
IBM terminal types, the 
background of the work area is 
displayed in black. 

History Scroll Bar For non-IBM emulations only. 

Enables you to scroll up and 
down through the PowerTerm 
WTC window to view previously 
displayed data. Default: 
displayed. 

Soft Buttons Contains a series of buttons 
displayed above the Status bar 
that you can program to 
execute specific script 
commands. 
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Communication LEDs Indicates communication 
activity. 

Emulator Type Displays the current terminal 
emulation type selected from 
the Emulation tab in the 
Terminal Setup dialog. 

Cursor Position Counter Displays the current line and 
column position of the text 
cursor in the work area. 

Caps Indicates whether the keyboard 
is in Caps lock mode. 

Hold Indicates whether the screen is 
in hold or frozen mode. 

Status Indicator – On Line, 
Off Line, Printer, Auto Prt 

• The status indicator reads On 
Line when communication is 
established. 

• The indicator reads Printer 
when data is transmitted with a 
printing request to the slave 
printer. The color of the 
indicator is the same as when 
PowerTerm WTC is in On Line 
mode, for example, the printer 
will appear in red if the system 
was On Line when the printing 
request arrived. 

• The data is sent to the screen 
and printer, and the indicator 
reads Auto Prt, when the 
terminal is in Automatic Printing 
mode. 

Macro/Message Display Area Displays system messages or a 
script sequence, as you type it 
in the work area. 

Window border and corners Changes the size of the 
window. The characters that 
appear in the work area are 
scaled up or down so that all 
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the information always remains 
in view. 

2.2 Menu Bar 
The PowerTerm WTC Menu bar displays the main PowerTerm WTC functions 
in dropdown menus. The following is a brief description of each menu and 
the functions that it can perform.  

2.2.1 File Menu 
The File menu provides options to create, save and restore a terminal setup 
file, as well as to create an icon for your current PowerTerm WTC settings, 
also open keyboard and Power Pad settings and save them. You can also use 
this menu to set printing parameters, print, and to open a new instance of 
the PowerTerm WTC window. 

New Terminal Setup Restores the default parameters 
including the terminal display 
colors. If you have changed 
terminal parameters since the 
last save, PowerTerm WTC 
displays a warning message 
asking whether or not to save 
the latest changes. The 
message point to the terminal 
settings file currently loaded. 

Open Terminal Setup Opens the Open File dialog, 
which enables you to select and 
open an existing setup file. 

Save Terminal Setup Saves both terminal setup and 
communication parameters to 
the current setup file. 

Save Terminal Setup As Opens the Save File As dialog, 
which enables you to save the 
current setup configuration 
under a different name. 

Save as Icon Opens the Save as Icon dialog to 
create an icon for the current 
PowerTerm WTC settings file. 
This enables you to start a 
session automatically with the 
desired parameters either by 

17 of 127 



  PowerTerm WTC: General Reference 

accessing the icon from the 
Windows Start menu or by 
double-clicking it on your 
desktop. 

Open Keyboard File Opens the Open Keyboard File 
dialog, which enables you to 
open keyboard mapping 
settings that have previously 
been saved. 

Save Keyboard file Opens the Save Keyboard File 
dialog, which enables you to 
save separate keyboard 
mapping settings in a separate 
file and open them at a later 
date. 

Open Power Pad file Opens the Open Power Pad File 
dialog, which enables you to 
open Power Pad settings that 
have previously been saved. 

Save Power Pad File Opens the Save Power Pad File 
dialog, which enables you to 
save Power Pad settings in a 
separate file and open them at 
a later date. 

Print Screen Prints the contents of the work 
area, or the selected text. 

Print Selection Prints only the selected text. 

Print Setup Displays the Print Setup dialog, 
which contains printing 
parameters. Displayed 
parameters change according to 
the printer you selected. 

• The Default Printer parameter 
enables you to send the output 
to the default printer selected. 

• The Specific Printer parameter 
allows you to select one of the 
currently installed printers. 
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Print Setup for Additional 
Printers 

Displays the Print Setup dialog 
for any other printer you might 
want to use. 

Start/Stop Auto Print Prints all the data displayed in 
the work area. This option 
toggles between Start and Stop 
Auto Print. 

Close Print Queue Closes the print queue 
manually. 

Form Feed Executes a form feed on the 
printer. 

Line Feed Executes a line feed on the 
printer. 

New Terminal Window Opens a new instance of the 
PowerTerm WTC window. This 
enables you to run several 
sessions concurrently and 
simulate more than one 
terminal type. You can access a 
session by switching windows. 
After opening a new terminal 
window, you should define 
terminal and communication 
parameters before connecting 
to a host. 

Exit All Sessions Exits all PowerTerm WTC 
sessions at once. 

Exit Exits the current PowerTerm 
WTC session. 

2.2.2 Edit Menu 
The Edit menu provides options to select, clear, and reverse text in the 
PowerTerm WTC window and delete the contents of the history buffer. The 
Edit menu also provides standard editing commands (e.g. cut/copy/paste), 
in addition to commands that enable you to copy data to a file and copy data 
automatically to the clipboard. 
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Select Screen Selects the contents of the 
entire work area. 

Clear Screen Captures the entire PowerTerm 
WTC screen and passes the 
data to the history buffer. 

Clear History Deletes the entire contents of 
the history or scroll back buffer. 
This command is only available 
when the history buffer is in 
use. 

Reverse Screen For RTL languages only. 

Reverses the screen so that you 
can type from left to right or 
right to left, depending on the 
language you use. 

Cut For IBM emulations only. 

Cuts the selected text and 
places it on the clipboard. 

Copy Copies marked text to the 
clipboard when the Automatic 
Copy option in the Edit menu is 
not active.  

Paste Pastes the clipboard contents 
into the work area. Right-click 
sends data stored on the 
clipboard to the host. 
Equivalent to actually typing 
the contents of the clipboard on 
the host screen. 

Copy Table Copies a table to a spreadsheet 
while maintaining the contents 
of each of its individual cells. 

Copy as Bitmap Copies the screen or screen 
selection as a bitmap. By 
default the screen capture will 
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appear in color but you can also 
save it in black and white. 

The screen capture can also be 
automatically copied into an 
untitled email in your Outlook 
program. 

Copy to File Copies selected information to a 
file. If no text is selected, the 
entire screen is written to the 
file. 

Automatic Copy Automatically copies selected 
text to the clipboard with no 
need to select the Copy option. 

Copy Right to Left For RTL languages only. 

Reverses the order of the 
letters in the work that was 
copied to the clipboard when 
displayed. 

2.2.3 Terminal Menu 
The Terminal menu provides options to define and reset connection 
parameters, set the system to be online or offline, and freeze or unfreeze 
the screen. You can also select the fonts and languages (in versions that 
support it) to be displayed in the PowerTerm WTC window. 

Setup Opens the Terminal Setup 
dialog in which you can define 
settings for terminal emulation. 
This dialog contains different 
tab pages that enable you to 
define all aspects of your 
terminal setup. 

PowerTerm WTC Fonts Displays the default PowerTerm 
WTC fonts. These fonts are 
scaleable so that if the window 
shrinks, the fonts will shrink in 
relation to the size of the 
window. 

System Fonts Displays the PowerTerm WTC 
window with system fonts. 
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These fonts remain the same 
size, no matter what the size of 
the window. When you select 
your own system fonts, you can 
only select fixed size font. 

Reset Resets the VT terminal defaults. 
This command does not apply 
to PowerTerm WTC's exclusive 
terminal parameters (such as 
color). 

Online Sets the system to be online or 
offline. 

Hold Screen Stops communication and 
freezes the screen. To unfreeze 
the screen, reselect the 
command. 

Language option Selects the user interface 
language to appear in English, 
German, French, Italian, 
Spanish, Greek, or Czech. 

2.2.4 Communication Menu 
The Communication menu provides options to define and modify the 
communication (session) parameters, and to connect/disconnect a 
communication session. The Communication menu also provides file transfer 
options. It enables you to set and clear Data Terminal Ready (DTR) and 
Ready to Send (RTS) signals as well as select a modem from a list of 
existing modems. 

Connect Displays the Connect dialog, 
which enables you to define 
session parameters and connect 
to a host. 

Modify Connection Displays the Connect dialog, 
which enables you to modify 
connection parameters for COM 
type communication. 

Disconnect Disconnects the communication 
session. 
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Modem Setup Opens the Modem Setup dialog, 
which enables you to select a 
modem from a list of existing 
modems and initialization 
strings. It also enables you to 
add customized modem 
definitions and edit the 
initialization string provided. 

Reset Communication Resets the communication port 
for COM type communication. 

File Transfer Setup Displays the File Transfer Setup 
dialog, which enables you to 
define host and WTC data types 
for file transfer. 

Receive File Receives a file from the host via 
Kermit, Zmodem, Ymodem, 
Xmodem, Ascii or Binary. 

Send File Sends a file to the host via 
Kermit, Zmode, Ymodem, 
Xmodem, Ascii or Binary. 

SSL Setup Implements SSL security in your 
connections. 

Kerberos Manager Allows you to configure 
advanced Kerberos parameters 
and to perform advanced 
Kerberos actions. 

Run FTP Launches the PowerTerm WTC 
FTP client, capable of 
transferring files from one 
computer to another. 

File Transfer Setup Specifies type of data on the 
WTC and on the host. 

Utilities Displays signal options: 

Dial, enables you to dial a 
specific phone number for COM 
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type communication. 

Break, sends a break for COM 
type communication. Equivalent 
to <Ctrl>+<Break>. 

Set/Clear DTR, sets/clears DTR 
(Data Terminal Ready) signals. 

Set/Clear RTS, sets/clears RTS 
(Ready To Send) signals. 

AUX: Modify Connection, enables 
two-way slave printing to a serial 
printer. 

2.2.5 Sessions Menu 
The Session menu lists all the active PowerTerm WTC sessions and enables 
you to toggle between them. The first session generated is automatically 
named Session A, the next Session B, and so on. 

Display options Arranges the open sessions in 
different views. 

Session Manager Launches the Session Manager, 
a standalone component which 
allows you to activate and close 
a session by clicking an icon. 

Session… List of all active PowerTerm WTC 
sessions.  

2.2.6 Options Menu 
The Options menu enables you to map your keyboard and define the Power 
Pad display. It also enables you to store a session in a log file as well as 
provides options to customize your PowerTerm WTC screen. 

Keyboard Map Displays the Keyboard Mapping 
dialog, which enables you to 
map your WTC keys to host 
keys on the terminal keyboard. 

Power Pad Setup Displays the Power Pad Setup 
dialog, which enables you to 
adjust the number of buttons in 
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the Power Pad. 

Start/Stop Trace Stores received data in the 
Trace.log and Capture.log files. 
These files are located in the 
PowerTerm WTC folder. The 
menu command toggles 
between Start Trace and Stop 
Trace. 

Capture.log stores raw data, as 
received from the host. 

Trace.log stores formatted data 
with readable escape 
sequences.  

Input Trace Runs the contents of the 
Capture.log file, as if it were 
received from the host, and 
views the contents on the 
PowerTerm WTC desktop work 
area. 

Hide Menu Hides the Menu bar. 

To restore it, select Restore 
Menu from the Control Menu 
box. 

Hide/Show Tool Bar Hides/Shows the Toolbar. 

Hide/Show Buttons Hides/Shows the Soft buttons. 

Hide/Show Status Bar Hides/Shows the Status Bar. 

Hide/Show Power Pad Hides/Shows the floating Power 
Pad.  

2.2.7 Script Menu 
The Script menu provides options to create and run PSL commands. 

Run Script Displays the Run Script dialog, 
which enables you to select and 
run a script. 
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Edit Script Displays the Edit Script dialog, 
which enables you to edit an 
existing script or to create a 
new one. 

Script Command Displays the Script Command 
dialog, which enables you to 
run individual script commands. 

Start/Stop Script Recording Records a script automatically. 
After requesting Start Script 
Recording, the manual 
operations you perform in the 
emulation screen are recorded 
into a script file until you 
choose the Pause or Stop Script 
Recording command. 

Pause/Continue Script 
Recording 

Pauses or resumes the script 
recording. This enables you to 
exclude certain operations from 
recording. 

Activate Recorded Script Activates the script currently 
recorded in memory. The script 
is saved in memory while the 
PowerTerm WTC session is 
active. 

Save Recorded Script Enables you to save a script 
from memory to a specific file 
to be used at a later date. 

2.2.8 Help Menu 
The Help menu provides options for accessing the PowerTerm WTC online 
help (only provided on request) and product and license management 
information. 

About PowerTerm WTC Displays product and contact 
information. 
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2.3 Toolbar 
The PowerTerm WTC Toolbar contains icons, which provide shortcuts to 
frequently used menu options. The following is a brief description of the 
icons. You can also place the cursor over the icon to display its description 
as a tool tip. 

 Some emulation types display only part of the icons.  

Hold 
Screen/Release 
Hold  

 
For non-IBM emulations 
only. 

Suspends and resumes 
communication with the 
host. After you click the 
Hold Screen icon, it turns 
red. After you click the icon 
again, it changes back to 
green and update of the 
PowerTerm WTC window 
resumes. 

Equivalent to Terminal | 
Hold Screen. 

Connect/Disconnect 
 

Opens the Connect dialog 
where you define session 
communication parameters 
and connect to the host.  

Disconnects an open 
session. 

Equivalent to 
Communication | Connect 
(Disconnect)

Cut  
 

Cuts the selected text. 

Equivalent to Edit | Cut. 

Copy to Clipboard  
 

Copies the selected data 
displayed in the work area 
to the clipboard. 

Equivalent to Edit | Copy. 
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Paste from 
Clipboard  

Pastes data from the 
clipboard to the host 
application. 

Equivalent to Edit | Paste. 

Print 
 

Prints selected text from 
the history buffer or the 
entire contents of the work 
area. 

Equivalent to File | Print 
Screen. 

Start/Stop Auto 
Print  

For non-IBM emulations 
only. 

Prints incoming data as it is 
displayed on the screen. 
Click the icon again and the 
automatic printing stops. 

Equivalent to File | Start 
Auto Print. 

Dial 
 

For non-IBM emulations. 

Dials a specific telephone 
number for COM type 
communication. 

Equivalent to 
Communication | Utilities | 
Dial. 

Start/Stop Script 
Recording  

Records manual operations 
in script form. Click the 
icon again and the script 
recording stops. 

Equivalent to Script | Start 
Script Recording. 

Change to 80 
Columns  

For non-IBM emulations 
only. 

Specifies an 80-column 
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display for the work area. 

Equivalent to Terminal | 
Setup | Display. 

Change to 132 
Columns  

For non-IBM emulations 
only. 

Specifies a 132-column 
display for the work area. 

Equivalent to Terminal | 
Setup | Display. 

Terminal Setup 
 

Displays the Terminal Setup 
dialog in which you can 
define terminal setup 
parameters. 

Equivalent to Terminal | 
Setup. 

Keyboard Mapping 
 

Opens the Keyboard 
Mapping dialog in which 
you can map WTC keys to 
host keys. 

Show/Hide Power 
Pad  

Displays the Power Pad. 
Click the icon again and the 
Power Pad closes. 

Equivalent to Options | 
Show Power Pad. 

Help Contents 
 

Displays product 
information. 

Equivalent to Help | 
Contents. (On request: 
Displays the PowerTerm 
WTC online help.) 

New Terminal 
Window  

Opens a new instance 
(window) of PowerTerm 
WTC. 
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Session 
 

Click the session's icon to 
bring it to the front.  

2.4 Hot Keys 
Hot keys are keyboard shortcuts that you can use instead of selecting menu 
commands. These hot keys refer to your standard WTC keyboard keys, 
before they are mapped to terminal keys. Once hot keys are mapped, they 
lose their original function and reflect the newly mapped terminal key. For 
example, if you map <Alt F4> to the <Backspace> key on the terminal 
keyboard, it performs the function of a <Backspace> key. 

The following table lists the default PowerTerm WTC hot keys: 

Alt F4 Exit 

Alt F6 Open a new terminal window 

Alt F9 Activate script 

Ctrl+Alt+F9 Start/Stop script recording 

Ctrl+Shift+P Activate recorded script 

Alt F10 Select screen 

Alt F11 Clear screen 

Alt F12 Reverse screen. 

IBM 5250 emulations not 
included. 

Scroll Lock Hold screen 

Pause Change the cursor shape 

Ctrl Up Arrow Scroll up one line 

Ctrl Down Arrow Scroll down one line 

Ctrl Home Scroll to the beginning of the 
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history buffer 

Ctrl End Scroll to the end of the history 
buffer 

Ctrl Page Up Scroll up one page 

Ctrl Page Down Scroll down one page 

Shift+Ctrl+X Switch focus to session X 

X is the session letter (A…Z) 
displayed in the PowerTerm 
WTC windows Title bar. 

Ctrl+Spacebar Switch to next active session 

2.5 Connection Dialog 
 The parameter options change according to emulation and Session Type 

(protocol) selected.  
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Session Type Parameters 

TELNET Uses the Telnet protocol over 
TCP/IP for network 
communication. 

• Specify the host computer 
name or the IP address in the 
Host Name text box. 

• Specify the TELNET Port number 
(default 23). 

• The winsock.dll file must be in 
the search path. 
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COM Uses serial communication with 
the device's COM ports. 

• Define the Baud Rate, Port 
Number, Parity, Stop Bits and 
Flow Control 

• Optionally, specify a telephone 
(Dial) number. 

BAPI For TCP/IP connections with 
parameters similar to those of 
TELNET. 

• Verify that the BAPI support 
software is installed on your 
device before you use this 
option. 

CTERM Uses the DIGTAL CTERM 
protocol for network 
communication with a remote 
or local VAX/Open VMS host via 
DIGITAL PATHWORKS 32. 

• Specify the host computer 
name in the Node Name field. 

LAT Uses DIGITAL LAT protocol for 
network communication with a 
VAX/Open VMS host via 
DIGITAL PATHWORKS 32. 

• Specify Service and a Password 
(if required). 

TN3270 TELNET for 3270 emulations. 

• Select Use TN3270 Protocol if 
you want to work with TELNET 
SNA extensions. 

• Specify the LU Name of the host 
(LU name or LU pool). 

MS SNA Server For connection via Microsoft 
SNA Server. 

• Specify the LU Name (or LU 
pool). 
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NWSAA (IPX) For connection via IPX to Novel 
Netware for SAA. The Service 
Name is the same as Novel's 
Profile. 

• Select an LU Category. 

• Specify an asterisk (*), as the 
Server Name and PowerTerm 
WTC will connect to the 
appropriate Netware for SAA 
server. 

NWSSA (TCP/IP) Same as previous for TCP/IP 
connection. 

• Specify the server's IP address 
or host name in the Server 
Name field. 

TN5250 TELNET for 5250 emulations. 

APPC • Specify the appropriate AS/400 
names in Host Name and Device 
Name fields. 

• Select Auto SignOn if you want 
to skip the sign on stage. 

RLOGIN Uses the RLOGIN protocol over 
TCP/IP for network 
communication. 

• Specify the host computer 
name or IP address in the Host 
Name field. You can also specify 
the port number in the Host 
Name field. 

SUPERLAT This is a version of the LAT 
protocol for network 
communication with a 
VAX/Open VMS host, which 
requires Meridian's SUPERLAT. 

• Specify Service Name and 
Password (if required). 

NSVT For HP emulations. 
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2.6 Terminal Setup Dialog 
 The emulation type that you select changes the tabs (property pages) 

displayed in the Terminal Setup dialog and their options. 

 

 

Property Page Description 

Emulation Displays supported terminal 
emulations and enables you to 
select a terminal type. 

General Defines parameters for the 
terminal emulation type. 

Display Defines display settings for the 
PowerTerm WTC window. 

Keyboard Defines keyboard setup 
parameters. 

Printer Defines printer parameters. 

Tabs For VT emulations only. 

Defines tab stops in the work 
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area. 

Colors Defines color settings for the 
PowerTerm WTC window. 

Preferences Defines parameters that 
determine PowerTerm WTC 
behavior and automate 
processes. 

2.6.1 General Property Page 

Non-IBM Emulations 

 

 

Option Description 

Terminal ID Determines the ID returned by 
the emulation program to the 
host. Verify that you select an 
ID that the host 
application/system recognizes. 

NRC Set Determines the communication 
and keyboard character set for 
7-bit data only.  
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UPS Set Determines the communication 
and keyboard character set for 
8-bit data only. 

8 bit Controls Enables when UPS Set is 
specified as Code Page 437 and 
up.  

Disable, determines if 0x80 to 
0xAF are displayed characters. 

Enable, determines if 0x80 to 
0xAD are control characters. 

0x9B, all characters are 
displayed characters except 
0x9B, which is a control 
character. 

Online Equivalent to Terminal | On Line 
(Off Line). 

New Line Determines whether the 
<Enter> key generates only a 
carriage return or a carriage 
return/line feed combination. 

Use 8 Bit Data Characters Select this parameter if the 
communicated data is in 8-bit 
character format. 

Clear it for 7-bit characters. 
When cleared, the 8th bit is 
truncated. If you receive 7-bit 
data, you can convert it to 8-bit 
data for printing on the slave 
printer. 

User Defined Keys (UDK) Determines whether 
applications on the host system 
can override your user-defined 
keys (UDKs) when you have 
defined a function key that 
conflicts with how the host 
wants to use this key. 

Locked, prevents UDKs from 
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being overridden. 

Unlocked, determines whether 
the four arrows keys generate 
ANSI standard (Normal) control 
sequences for moving the 
cursor, or generate customized 
Application program functions. 

Cursor Keys For VT emulations only. 

Determines the behavior of the 
four arrow keys. 

Normal, generates ANSI-
standard control sequences for 
moving the cursor. 

Application, generates 
customized application program 
functions. 

Keypad For VT emulations only. 

Determines the effects of the 
numeric keypad on your 
keyboard. 

Numeric, keypad keys insert 
numbers. For example, pressing 
<7> on the numeric keyboard 
is the same as typing '7' on the 
keyboard. 

Application, keypad keys 
generate control sequences that 
can be used by some 
applications. 

(Use) NumLock, enables or 
disables the NumLock keyboard 
function in respect to the above 
Numeric and Application 
modes: 
"NumLock" checkbox not 
checked, the NumLock key is a 
regular emulation key that has 
been mapped/defined as PF1 
(default) or any other key. The 
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NumLock key will not change 
the NumLock keyboard status. 
"NumLock" checkbox checked: 
Numeric Keypad Mode, the 
NumLock key toggles between 
function states: enabling 
numeric keys (when lit) or 
arrow keys (when not lit). 
Application Keypad Mode, the 
NumLock key toggles between 
function states. Enabling 
numeric keys (when lit) or 
application keys (when not lit). 

Cursor coupling Vertical, determines whether 
the user window pans with the 
cursor when the cursor moves 
past the top or bottom border 
of the user window. 

Page, determines if a new page 
appears in the display when the 
cursor moves to a new page. 

Status Line None, displays an emulation 
screen without the status line. 

Indicator, displays the status 
line.

Host Writeable, disaplays the 
status line sent by the host. 

Label Line For ASCII emulations only. 

Displays a status line on the top 
and bottom line of the 
emulation screen. 

39 of 127 



  PowerTerm WTC: General Reference 

IBM Emulations 

 

 

Option Description 

General ID, determines the ID returned 
by the emulation program to 
the host. Make sure you select 
an ID that the host application 
recognizes. 

Unscaled Screen, when this 
parameter is cleared, the 
characters appearing in the 
work area are scaled. A change 
in the size of the desktop 
causes the fonts to shrink in 
relation to the size of the 
window. Select this parameter 
if you want to disable this 
feature. 

Show Respone Time, displays 
the number of seconds that 
elapsed between the time data 
was sent to the host and the 
host response time. 
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Cursor Ruler Select Visible to display full-
screen, vertical or horizontal 
lines as a cursor ruler (cross 
hair guide). 

Cross Hair, displays the cursor 
ruler as a horizontal and 
vertical line. 

Horizontal, displays the cursor 
ruler as a horizontal line only. 

Vertical, displays the cursor 
ruler as a vertical line only. 

Cursor Controls the cursor appearance 
and functionality: 

Block/Underline/Visible/Blink, 
controls the cursor appearance. 

Ins Change, when selected it 
enables toggling the cursor 
between underline and block 
appearance, by clicking the Ins 
(insert) button. 

Appearance Power GUI, displays data in a 
window with 3D look & feel. Use 
system fonts larger than 10 pt. 
for optimized results. 

Show Frame, places a frame 
around the text area of the 
emulation. 

HLLAPI Names The names of an hllapi session 
can either be short or long. 

Short and Long, enables you to 
specify the short and long hllapi 
names. 

Code Page Specifies the host and WTC 
(keyboard) character sets. 
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Alternate Size Enable, select to override the 
terminal alternate size with a 
specific size. 

Rows/Columns, type the 
required number. 

2.6.2 Display Property Page 
For non-IBM emulations only. 

 

 

Option Description 

General Reverse Display Colors, reverse 
the text and background colors 
in the work area. 

Unscaled Screen, when this 
parameter is cleared the 
characters appearing in the 
work are scaled. A change in 
the size of the desktop causes 
the fonts to shrink in elation to 
the size of the window. Select 
this parameter if you want to 
disable this feature. 

42 of 127 



  PowerTerm WTC: General Reference 

Autowrap Characters, wraps 
words at the end of a line and 
the cursor moves to the next 
line. 

History Scroll Bar, displays the 
vertical history scroll bar along 
the right edge of the 
PowerTerm WTC screen. This 
enables you to scroll through 
the data displayed previously 
on the screen. If the host 
transmits during scrolling, the 
display automatically scrolls 
back to its current position. 
NOTE Selecting Clear History 
from the Edit menu can erase 
the History buffer. 

Cursor Ruler Select Visible to display full-
screen, vertical or horizontal 
lines as a cursor ruler (cross 
hair guide). 

Cross Hair, displays the cursor 
ruler as a horizontal and 
vertical line. 

Horizontal, displays the cursor 
rules as a horizontal line only. 
Vertical, displays the cursor 
ruler as a vertical line only. 

Cursor Controls the cursor appearance 
and functionality: 

Block/Underline/Visible/Blink, 
controls the cursor appearance. 

Ins Change, when selected, it 
enables toggling the cursor 
between underline and block 
appearance by pressing the 
Insert key. 

Ctrl Characters Display, displays the control 
characters. 

43 of 127 



  PowerTerm WTC: General Reference 

Interpret, displays normal text 
as affected by control 
characters. 

Power GUI Displays data in a window with 
3D look & feel. Use System 
fonts larger than 10 pt for 
optimized results. 

Show Frame Places a frame around the text 
area of the emulation. 

Dimensions Determines the number of 
characters (columns) per 
displayed line, and the number 
of lines to be displayed in the 
work area. Characters are 
scaled according to the selected 
values. Type a different value in 
the Other box instead of 
choosing one of the standard 
options (80 and 132). 

Scrolling Determines the pace at which 
data is displayed in the work 
area as it arrives. If you select 
Jump, you should determine 
the Jump Scroll Speed that is 
measured in number of line 
units. The higher the value, the 
faster the scrolling. 

Unlimited, displays data without 
delaying communication. 

Page, scrolls data by full 
screens. 

Smooth, is equivalent to a Jump 
Scroll Speed of 1. 

Enable Soft fonts Enables you to work with VT 
soft fonts. The fonts will be 
loaded from the host 
application. 
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2.6.3 Keyboard Property Page 

Non-IBM Emulations 

 
 

Option Description 

Capslock Mode Determines the behavior of the 
Caps Lock key. 

Caps (Unix), locks alphabet keys 
on main keypad in uppercase. 

Shift, locks alphabet and 
numeric keys on main keypad 
in shift setting. Pressing the 
shift button on your keyboard 
will release shift-lock mode. 

Reverse (Win), Same behavior 
as Caps Lock, however pressing 
the shift button on your 
keyboard reverses the caps 
operation. 

Always On, enables you to 
toggle to a different application 
and turn Caps Lock mode off. 
On return to PowerTerm WTC it 
will automatically revert to Caps 
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Lock on. 

Backspace Key Sends Delete Determines whether the 
<Backspace> key sends Delete 
or an actual Backspace. 

Auto Repeat Repeatedly displays the 
character whose key is being 
continuously pressed down. 

Key Click Issues a click sound when you 
press a key on the keyboard. 

Warning Bell Determines whether the 
terminal sounds a bell tone 
when receiving the "bell" 
(ASCII 7) character. For 
operating errors, mail 
messages, etc. 

Margin Bell Determines whether the 
terminal sounds a bell tone 
when the cursor reaches the 
right margin. 

Numpad Decimal sends 
Comma 

Specifies that the Numeric 
Pad's decimal key sends a 
comma instead of a decimal. 

Use Emulator Alt Keys Select to make an <Alt> key 
perform the terminal operation 
even if Windows OS has an 
operation mapped to the same 
key. 

Local Echo Determines whether keyboard 
input is displayed (echoed) on 
your screen. 

Select, to display the keyboard 
input even if the host system 
does not echo your input. 

Clear, to send the keyboard 
input to the host system 
without being displayed on the 
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screen (unless the host system 
echoes the characters). 

Use VT Keyboard Mode Changes your keyboard into a 
Digital VT keyboard mode. In 
this mode, the WTC keyboard 
operates as close to a VT 
keyboard as possible, and takes 
full advantage of LK450 Digital 
keyboards. 

Answerback Message Specifies an answerback 
message and its display. 

Clear, deletes the message. 

Conceal, hides the message 
without being deleted. 

Auto Answerback Determines whether the 
terminal automatically sends 
the message to the host system 
after you make the connection. 
This is useful if your 
answerback message is a 
command to the host system. 
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IBM 3270  Emulations 

 
 

Option Description 

Capslock Mode Determines the behavior of the 
Caps Lock key. 

Caps (Unix), locks alphabet keys 
on main keypad in uppercase. 

Shift, locks alphabet and 
numeric keys on main keypad 
in shift setting. Pressing the 
shift button on your keyboard 
will release shift-lock mode. 

Reverse (Win), Same behavior 
as Caps Lock, however pressing 
the shift button on your 
keyboard reverses the caps 
operation. 

Always On, enables you to 
toggle to a different application 
and turn Caps Lock mode off. 
On return to PowerTerm WTC it 
will automatically revert to Caps 
Lock on. 
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Backspace Deletes Select to delete characters by 
pressing the Backspace key on 
your keyboard. 

Auto Repeat Repeatedly displays the 
character for which its key is 
being continuously pressed 
down. 

Key Click Issue a click sound when you 
press a key on the keyboard. 

Lock Numeric Field Determines whether the 
keyboard is locked when you 
try to enter non-numeric data. 

Typeahead Types data ahead, before the 
host responds. 

Automatic reset Key If the Keyboard is locked, a 
reset key sequence is 
generated prior to when you 
click on the tab key to advance 
to the next field. 

Numpad Decimal Sends 
Comma 

Determines whether the 
Numeric Pad sends a comma 
instead of a decimal. 

Use Emulator Alt Keys Select to make an <Alt> key 
perform the terminal operation 
even if Windows OS has an 
operation mapped to the same 
key. 

Non SNA System Wait Determines whether the 
System Wait in the IBM 3270 
emulation will act as a System 
Wait in a non-SNA terminal. 
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IBM 5250 Emulations 

 

 

Option Description 

Capslock Mode Determines the behavior of the 
Caps Lock key. 

Caps (Unix), locks alphabet keys 
on main keypad in uppercase. 

Shift, locks alphabet and 
numeric keys on main keypad 
in shift setting. Pressing the 
shift button on your keyboard 
will release shift-lock mode. 

Reverse (Win), Same behavior 
as Caps Lock, however pressing 
the shift button on your 
keyboard reverses the caps 
operation. 

Always On, enables you to 
toggle to a different application 
and turn Caps Lock mode off. 
On return to PowerTerm WTC it 
will automatically revert to Caps 
Lock on. 
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Backspace Deletes Select to delete characters by 
pressing the Backspace key on 
your keyboard. 

Auto Repeat Repeatedly displays the 
character for which its key is 
being continuously pressed 
down. 

Key Click Issue a click sound when you 
press a key on the keyboard. 

Warning Bell Determines whether the 
terminal sounds a bell tone 
when receiving the "bell" 
(ASCII 7) character. For 
operating errors, mail 
messages, etc. 

Typeahead Types data ahead, before the 
host responds. 

Automatic reset Key If the Keyboard is locked, a 
reset key sequence is 
generated prior to when you 
click on the tab key to advance 
to the next field. 

Numpad Decimal Sends 
Comma 

Determines whether the 
Numeric Pad sends a comma 
instead of a decimal. 

Use Emulator Alt Keys Select to make an <Alt> key 
perform the terminal operation 
even if Windows OS has an 
operation mapped to the same 
key. 
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2.6.4 Printer Property Page 

 
 

Option Description 

Print Device Allows you to select a printing 
output channel. 

None, no destination was 
assigned. The Device Name is 
disabled. Printer data is 
received by the terminal, but 
discarded (not printed). 

Device, sends printing to the 
device you designate in the 
Device Name text box. This can 
be a device such as COM1, 
COM2, COM3, etc. in the Device 
Name text box, you can also 
specify communication 
parameters. For example: COM 
1:9600,8. 

Print Manager, sends printing to 
the network printer. You must 
hen perform the following: 
1. Select File | Print Setup. 
2. Select Network from Port 
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field. 
3. Type UNC (Universal Naming 
Convention) in the Net Path. 
For example, \\net1\hp4000

File, sends printing to the file 
specified in the File Name text 
field. 

AUX, sends printing to the 
auxiliary port. 

Device Name The available printing devices 
are: LPT1: (default) COM x: 

File Name Specify if you want Append or 
Overwrite mode. NOTE that lpt1 
is a saved word and cannot be 
used as a file name. 

Use Form Feed Adds a form feed (page eject) 
after each printing job. This 
depends upon the available 
connections on your device. 

Print Line Graphics As Text Converts line graphics to text. 
This speeds up printing on a 
slow dot-matrix printer. 

LF->CRLF Adds a line feed after each 
single carriage return (one that 
has no line feed following it) 
when in slave printing mode. 

Print Screen Data Conversion Converts data to Host or UTF-8 
character sets, or print in 
Graphics mode. 

None, does not convert data. 

Slave Printer Data 
Conversion 

Converts data to Host or UTF-8 
character sets, or prints in 
Graphics mode for slave 
printing. 

None, does not convert data. 
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Slave Printer Job Delimiter For non-IBM emulations only. 

Specifies the job delimiter 
character that will divide the 
data into print jobs, thus 
disabling the escape sequences 
arriving from the host 
application. 

Delay for Print Closing The command to close the 
printer queue is delayed by the 
number of seconds that you 
determine. This command only 
takes effect if no open 
command is issued in the 
meantime. Important for 
printing to cut sheet printers 
(for example, inkjets/lasers) 
and network printers. 
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2.6.5 Advanced Printing Setup 

 
 

Option Description 

Printer Type Specifies the destination 
printer. Edit enables you to edit 
the printer configuration file. 

Margins Specifies the space between the 
edge of the printout page and 
the border of the printing. 

Font Printer default font and size will 
be applied to the output when 
Ignore is selected. Otherwise, 
User input will be applied. 
Select the desired font from the 
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Font dropdown list. 

CPI Character per Inch 

LPI Lines per Inch 

Printer Columns/Rows For graphic printing only. 

Determines the number of 
printer columns/rows in the 
output. Select Ignore to apply 
the number of columns on your 
emulation screen to the output. 

Page Type for Text Printing Specifies the page type (for 
example, A3, A4, A5 etc.) 

Form Feed Defines the form type of the 
printer. PowerTerm WTC 
provides the following three 
types: 

AUTOCUT, single-cut sheets are 
automatically fed into the 
printer. Most printers require a 
sheet feed attachment. 

CONT, continuous sheets are 
used by printers that have a 
tractor feed attachment on the 
device. 

CUT, single-cut sheets are 
manually fed into the printer. 

Orientation Specifies the orientation of the 
printed output. The default 
depends on your printer' 
settings. Options are: Ignore 
Portrait Landscape. 

Enable AS/400 Host Print 
Transform 

For IBM 5250 printer 
emulations only. 

Enabled, pass through 
(transparent) mode. The host 
sends (ASCII) command and 
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text directly to the printer. Non-
graphic printing only. Disabled, 
the host sends (EBCDIC) 5250 
SCS format commands and text 
to the emulation. The 
emulation, in turn, translates to 
printer specific commands. 

Customizing Object Specifies the object name that 
you have previously defined on 
the AS/400. Enabled only for 
"Other" printer models. 

Library Specifies the customizing 
object's library on the AS/400. 
Enabled only for "Other" printer 
models. 

Drawer 1 Specifies the size for the paper 
in Paper Source 1. 

Drawer 2 Specifies the size for the paper 
in Paper Source 2. 

Envelope Hopper Specifies the size of the 
envelope. 

Supports ASCII Code-Page 
899 

Specifies whether the printer 
has Code Page 899 installed. 

2.6.6 Tabs Property Page 
For VT emulations only. 
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Options Description 

Tabs Stops Click anywhere within the Tab 
Stops area to set tab stops 
manually. 

Set Every Sets a tab stop in increments of 
a number typed in the adjacent 
text field. 

Clear All Clears all tab stops. 
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2.6.7 Colors Property Page 

Non-IBM Emulations 

 
 

Option Description 

Preview Box Shows the result of your 
selections. 

Enable Underline Enables underlined characters. 

Clear to disable displaying data 
with the underline, for data 
transmitted from the host with 
the Underline attribute. 

Enable Blink Enables blinking. 

Clear to disable blinking data, 
for data transmitted from the 
host with the blink attribute. 

Coloring method dropdown 
list 

Default, uses the default color 
type for each emulation type: 
VT and Siemens – Attribute & 
ANSI colors 
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ANSI and HP – ANSI colors 
All others – Attribute colors (i.e. 
not affected by setting to a 
different value). 

Attribute, colors based on the 
attributes. For example, you 
can select different colors for 
bold, for underline, and for 
bold/underline. 

ANSI, colors based on host-
defined colors. For example, 
the host sends "red foreground 
on blue background" however 
you can select the default ANSI 
color. Different attributes do 
not affect colors. 

Attribute & ANSI, uses both 
Attribute and ANSI colors as 
explained above. 

ANSI 8 Color Mode For ANSI emulations only. 

A regular terminal has 16 colors 
(8 colors with the Bold attribute 
applied to them and 8 colors 
without the Bold attribute 
applied to them). The 
Background color never has the 
bold attribute (therefore it is 
"dark") while the Text 
(foreground) is always mapped 
to the color with the Bold 
(bright, light) attribute. 

Non-selected, each entity (text, 
background) can have any of 
the 16 colors mapped to them. 

Selected, each entity (text, 
background) can have any of 
the 8 colors mapped to them. 

Color Frame Select to draw a color frame on 
the screen. 
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Select Attribute Select the attribute for which 
you want to define foreground 
and background colors. 
Attributes change according to 
the emulation type you selected 
in the Connection properties 
dialog. Generally, the attribute 
of the entire screen is Normal. 
The color for the Normal 
attribute determines the color 
of the entire work area. 

Text Select the color that will apply 
to the text (foreground) of the 
display. 

Background Select the color that will apply 
to the background of the text. 

IBM Emulations 

 
 

Option Description 

Preview Box Shows the result of your 
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selections. 

Enable Underline Enables underlined characters. 

Clear to disable displaying data 
with the underline, for data 
transmitted from the host with 
the Underline attribute. 

Enable Blink Enables blinking. 

Clear to disable blinking data, 
for data transmitted from the 
host with the blink attribute. 

Column Separator For IBM 5250 emulations only. 

Displays a period as a column 
separator in fields with the 
column separator attribute. 

Color Frame Select to draw a color frame on 
the screen. 

Select Attribute Select the attribute for which 
you want to define foreground 
and background colors. 
Attributes change according to 
the emulation type you selected 
in the Connection properties 
dialog. Generally, the attribute 
of the entire screen is Normal. 
The color for the Normal 
attribute determines the color 
of the entire work area. 

Text Select the color that will apply 
to the text (foreground) of the 
display. 

Background Select the color that will apply 
to the background of the text. 
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2.6.8 Preferences Property Page 

 
 

Option Description 

On Terminal Setup File Open Auto Connect, establishes a 
connection immediately with 
the parameters saved in the 
terminal parameters file. 

Show Connect Dialog Box, does 
not establish a connection 
immediately, rather the 
Connect dialog opens and 
enables you to select required 
connection. 

Do not Connect, opens only the 
PowerTerm window. 

Window Title Specifies a customized name 
that appears on the title bar. 

History Buffer Specifies the size of the buffer 
in which data is stored, by 
selecting an option from the 
dropdown list. 
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On PowerTerm WTC Exit Save Terminal Setup, the new 
terminal parameters (if you 
changed them during the 
session) are saved to the 
current terminal setup file. 

Confirm Save, terminal 
parameters are not saved 
automatically. PowerTerm WTC 
displays a dialog where you can 
decide whether or not to save 
any changes you did to the 
settings during the session. 

Confirm Disconnect Session, if 
you close PowerTerm WTC 
during a session, you will be 
required to confirm disconnect. 

Save Window Size & Position, 
saves the size and position of 
the emulation window. The next 
time you open PowerTerm, the 
window appears with the 
desired size at the set position. 

Inactivity Timeout, specifies the 
time limit for keyboard 
inactivity, after which 
PowerTerm WTC shuts down. 

On Session Exit Auto Reconnect, re-establishes 
communication if the line was 
disconnected. 

Auto Exit PowerTerm WTC, 
closes PowerTerm WTC 
altogether on disconnect. 

2.7 Security Settings Dialogs 
2.7.1 SSL Security 

In the SSL Security Setup dialog you specify your SSL security behavior. You 
may select to accept only certificates that exist in the certificates path or 
any incoming certificate. You can also specify if you want to display unknown 
certificates at connection time and whether you want to save them. 
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2.7.2 SSH Security 
In the SSH Security dialog you can specify what type of SSH properties you 
require. 
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2.7.3 Kerberos Security 
In the Kerberos Manager dialog you can configure advanced Kerberos 
parameters and perform advanced Kerberos actions. 

 

 

Menu Description 

Actions Change Password 

Refresh 

Close 

Tickets Get, opens the Kerberos Login 
dialog where you can request to 
get tickets. 

Delete, removes all the Kerberos 
Tickets. 

Renew, enables you to prolong 
time limited tickets. 

Import, searches for your 
Window Kerberos Tickets and 
imports them. 

Options Realm Configuration, opens the 
Realm configuration dialog 
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where you can specify with 
which domain your computer is 
associated. 
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3 Starting and Stopping Sessions 
When PowerTerm WTC is used for the first time, the PowerTerm WTC 
window is automatically displayed together with the Connect dialog. After 
the connection parameters have been defined, the Connect dialog will be 
displayed according to your selected options. 

You can determine PowerTerm WTC behavior and automate processes in the 
Preferences property pages. These remain active until you change them. For 
example, if you select to connect automatically at PowerTerm WTC startup, 
you will always be connected when you open PowerTerm WTC. Other 
behaviors you can customize are for example auto-reconnect and keyboard 
inactivity time limit. 

PowerTerm WTC opens with the default terminal setup file. You can also 
open PowerTerm WTC using a customized setup file, or a script file. 

Once you have defined terminal and communication parameters, you can 
then connect to a host. For more information on connections, see chapter 
Defining Connections. 

The communication mode appears beside the application name on the 
PowerTerm WTC window title bar. When communication ends, the mode 
name disappears from view. 

When working with more than one host, PowerTerm WTC enables you to 
connect to a host using customized PSL scripts. You need to define a 
different script with the name of each host. This option provides you with a 
Windows shortcut to a host. For more information about scripts, see chapter 
Scripts. 

PowerTerm WTC also provides the option to modify connection parameters 
for COM type communications. This option is only available once you are 
connected to a host. 

 To start PowerTerm WTC: 

1. Click the Start button in the Task bar. 

2. Select Programs | Ericom Software | PowerTerm WTC | PowerTerm WTC. The 
application is launched. 

 To define preferences: 

1. Select Terminal | Setup. The Terminal Setup dialog appears. 

2. Select the Preferences tab. The Preferences property page is displayed. 

3. Select the parameters that you require. 

68 of 127 



  Starting and Stopping Sessions 

3.1 Starting PowerTerm WTC Using a Setup File 
PowerTerm WTC can be started using a default or customized setup file. A 
setup file contains both communication session parameters and terminal 
setup parameters. It is in text format and can be edited using a text editor. 

The Default Setup file, called ptdef.pts, is used with single host connections. 
When you open PowerTerm WTC, it automatically uses this file to initiate 
terminal setup and connection parameters. 

A customized setup file is used with multiple host connections and when you 
want to start PowerTerm WTC with predefined communication and terminal 
setup parameters for a specific connection. This can be done by using a 
command or creating a Windows shortcut. Before you create a shortcut to a 
setup file, you first need to create and save the setup file in PowerTerm 
WTC. 

 To start PowerTerm WTC with a customized setup file: 

Double-click the PowerTerm WTC shortcut icon on your desktop or access it 
from the Start menu. Your session starts automatically with the predefined 
parameters. 

 To use a setup file during PowerTerm WTC session: 

A terminal setup file can also be opened during a PowerTerm WTC session to 
run a session using predefined terminal setup and communication 
parameters. There are two options to use a setup file: 

• Select File | Open Terminal Setup. The Open File dialog appears in which you 
can select a setup file. 

• Select Communication | Connect. The Connect dialog appears in which you 
can specify the name of the setup file to be run before communication is 
established. 

3.2 Starting PowerTerm WTC Using a Script 
You can also launch PowerTerm WTC and run a script immediately upon 
launching. Scripts are created with PowerTerm WTC Script Language (PSL) 
and enable you to automate tasks. For example you can use a script to 
automatically connect to a specific host. 

3.3 Starting PowerTerm WTC with Auto Connect 
The Auto Connect option enables you to automatically connect to a specific 
terminal using the parameters in the default setup file. 

 To access the Auto Connect option: 

1. Select Terminal | Setup. The Terminal Setup dialog appears. 

2. Click the Preferences tab. The Preferences Property page is displayed. 

3. Select Auto Connect. 
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4. Click OK. 

3.4 Starting a New PowerTerm WTC Session 
PowerTerm WTC enables you to run two or more sessions concurrently by 
opening a new instance of the PowerTerm WTC window. Each session is 
identified by a letter (starting with A), which appears in the session window 
title bar. A session is assigned the first available letter. For example, if A, B 
and D are opened the next session opened is assigned C. 

 To open a new instance of the PowerTerm WTC window: 

Select File | New Terminal Window. A new instance of the PowerTerm WTC 
window opens. 

 To toggle between open sessions: 

Press <Ctrl>+<Spacebar>. 

 To switch to a specific session: 

You can either: 

• Press <Shift>+<Ctrl>+<X>, where X is the session letter. For example, if you 
want to work in session C, you would press <Shift>+<Ctrl>+<C>. 

• Click the desired session's icon in the Toolbar. 

• Select Sessions | the desired session. 

3.5 Ending a PowerTerm WTC Session 
You need to end the session(s) before exiting the PowerTerm WTC 
application. There are a few options to end a session: 

• Automatic closing - PowerTerm WTC enables you to close PowerTerm WTC 
automatically when you close a session. If you have modified terminal 
parameters during a session, a message displays asking if you want to save 
the setup file before closing. 

• User-initiated closing – Manually closing a session at any time. 

• User-initiated fast exit – Sometimes you require a fast exit while 
communication is in progress. PowerTerm WTC then reacts according to the 
parameters selected in the Preferences property page in the Terminal Setup 
dialog. 

You also have the options such as to require a confirmation when closing 
PowerTerm WTC during a session and to immediately re-connect again, 
automatically or manually (for non-IBM emulations only). 

 To manually close a session: 

Select Communication | Disconnect. 
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 To exit PowerTerm WTC: 

1. Select File | Exit. If you have changed the terminal settings, PowerTerm WTC 
displays a warning message asking if you want to update the terminal 
settings file. The message will point to the name of the setup file currently 
loaded. 

2. Click OK to update the file, or NO to cancel the latest changes and restore 
the original settings of the current setup file. 

 To fast exit the current session: 

Press <Alt>+<F4> on the keyboard. 

 To confirm disconnect: 

1. Select Terminal | Setup. The Terminal Setup dialog appears. 

2. Select the Preferences tab.  

3. Select Confirm Disconnect Session.  

4. Click OK. 

 To define parameters for automatic closing PowerTerm WTC when 
disconnecting a session: 

Close PowerTerm WTC altogether on disconnect. 

1. Select Terminal | Setup. The Terminal Setup dialog appears. 

2. Select the Preferences tab. 

3. Select Auto Exit PowerTerm in the On session exit section. 

4. Click OK. 

 To manually reconnect to a PowerTerm WTC session after exiting the 
current session: 

PowerTerm WTC displays the following message at session termination when 
Auto Exit PowerTerm in the Preferences tab is cleared: 

 

where the exit code (in this example '0') may have one of the following 
values: 

71 of 127 



  Starting and Stopping Sessions 

Zero (0) Communication ended 
successfully. 

Any number (other than 0) Communication aborted. The exit 
code points to the error that 
caused the problem. 

Press Enter on the keyboard.  

 To automatically reconnect a PowerTerm WTC session after exiting the 
current session: 

Re-establish communication if the line was disconnected. 

1. Select Terminal | Setup. The Terminal Setup dialog appears. 

2. Select the Preferences tab. 

3. Select Auto Reconnect in the On Session Exit section. 

4. Click OK. 

 To specify keyboard inactivity timeout: 

Specify the time limit for keyboard inactivity, after which PowerTerm WTC 
shuts down. 

1. Select Terminal | Setup. The Terminal Setup dialog appears. 

2. Select the Preferences tab. 

3. Enter the amount of minutes for Inactivity Timeout. 

4. Click OK. 
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4 Defining Emulations 
PowerTerm WTC enables you to define the terminal settings for connecting 
to a host. Once you have defined terminal settings, you can save them as a 
setup file. This file can be activated at startup or opened manually during a 
PowerTerm WTC session. You first have to select an emulation type and then 
define the other settings. 

The Emulation property page displays the emulation terminal types available 
with your version of PowerTerm WTC. The emulation type that you select 
changes the tabs (property pages) displayed in the Terminal Setup dialog. 
Some emulation types also change the look of the PowerTerm WTC desktop. 
For example, for IBM 3270 and 5250 terminal types the work area is black 
and the toolbar contains fewer icons. 

The General property page enables you to define parameters for the selected 
emulation type, such as: 

• The ID returned by the emulation program to the host. 

• Communication and keyboard character sets for both 7-bit and 8-bit data. 

• The behavior of the <Enter> key. 

• Whether applications on the host system can override your user-defined 
keys (UDKs). 

• Determines the effects of the numeric keypad on your keyboard. (VT 
emulations only.) 

 The selected host application will usually determine the default option. 

 To define emulation parameters: 

1. Select Terminal | Setup. The Terminal Setup dialog appears. 

2. Select the Emulation tab. The Emulation property page is displayed. 

3. Select the terminal type that you require from the list of supported 
emulations. 

4. Select the General tab. The General property page is displayed. 

5. Select the emulation parameters you require. 

6. Click OK. 

General parameters 

 To define host's ID response: 

This option is disabled when you are connected to a host. 

In the General tab, select Terminal ID from the dropdown list. 
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 To specify type of Cursor coupling: 

In the General tab, select Vertical to move the cursor past the top or bottom 
border of the user window, or Page to move the cursor to a new page. 

Non-IBM specific parameters 

 To define communication and keyboard character set: 

The available character sets change according to emulation type selected. 

In the General tab, select the NRC/UPS set required from the dropdown list. 

 To prevent the host to override your function keys: 

In the General tab, select User Defined Keys Locked. 

 To set the terminal to be online/offline: 

In the General tab, select or clear Online. 

 To define the Enter key behavior: 

In the General tab, select New Line. 

 To show a status line: 

Specify if you want your session's or the host's status line. 

In the General tab, select Indicator or Host Writable. 

IBM specific parameters 

 To define scaled/unscaled screen: 

In the General tab, select or clear Unscaled Screen.  

 To display host response time: 

In the General tab, select Show Response Time. 

 To define cursor appearance: 

In the General tab, select if you want a Block or Underline display. 

 To define GUI appearance: 

In the General tab, select Power GUI or Show Frame to display a "different" 
look of the work area. 

 To define the code page: 

In the General tab, select Host and PC Code Pages in the dropdown lists. 

 To specify the alternate size: 

In the General tab, select Enable and enter the Rows and Cols (columns) 
sizes. 
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VT specific parameters 

 To define the numeric keypad mode: 

The Num Lock key toggles between numeric keys or arrow keys. 

In the General tab, select Numeric and Numlock. 

 To define the application keypad mode: 

The Num Lock key toggles between numeric keys or application keys. 

In the General tab, select Application and Numlock. 

ASCII specific parameters 

 To show the label line: 

Display a status line at the top and the bottom of the emulation screen. 

In the General tab, select Label Line. 
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5 Defining Connections 
You can create different connections according to your needs. The 
connection parameters that you define will remain active only for the current 
session, unless you save them. 

After you saved your connection, you can modify its parameters, either from 
within the Connection Manager or by right-clicking the desired connection in 
the Session Manager. 

The default setup name is the name of the connection. Customized settings 
should be saved with a name other than its current name when the 
PowerTerm WTC session is running. 

You can also delete connections that are no longer in use. 

 To define a connection: 
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1. Select Communication | Connect. The Connect dialog appears. 

2. Select Session Type and enter required parameters. 

3. Select the Terminal Type and ID. 

4. Select the desired Security to be employed in the connection. 

5. Specify, if necessary, the Script and/or Setup files to be run upon 
connection. 

6. Click Connect. 

 To specify SSL Security parameters: 

1. Select SSL in the Security Type dropdown list and click Details. The SSL 
Security dialog is displayed: 

 

2. Select the desired SSL Version and click OK. 

 To specify SSH Security parameters: 

1. Select SSH in the Security Type dropdown list and click Details. The SSH 
Security dialog is displayed: 
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2. Select the desired SSH Version. 

3. Specify the SSH properties. 

4. Click OK. 

 To specify Kerberos Security parameters: 

1. Select Kerberos in the Security Type dropdown list and click Details. The 
Kerberos Security dialog is displayed: 

 

2. Specify User ID and select the desired options. 

3. Click OK. 
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 To save a connection: 

1. Select Communication | Connect. The Connect dialog appears. 

2. Select Session Type and enter required parameters. 

3. Select the Terminal Type and ID. 

4. Select the desired Security to be employed in the connection. 

5. Specify, if necessary, the Script and/or Setup files to be run upon 
connection. 

6. Click Save As. The Save Session dialog appears. 

7. Enter a Session Name and click OK. The connection is displayed in the 
Sessions List. 

 To use an existing configuration: 

1. Select Communication | Connect. The Connect dialog appears. 

2. Select the desired session from the Sessions List. 

3. Click Connect. 

 To modify connection parameters: 

1. Select Communication | Connect. The Connect dialog appears. 

2. Select the desired session from the Sessions List. 

3. Make desired changes in the parameters. 

4. Click Modify. 

 To rename a session: 

1. Select Communication | Connect. The Connect dialog appears. 

2. Select the desired session from the Sessions List. 

3. Click Rename. The Rename Session dialog appears. 

4. Enter a new Session Name and click OK. 

 To delete a connection: 

1. Select Communication | Connect. The Connect dialog appears. 

2. Select the desired session from the Sessions List. 

3. Click Delete. A confirmation notification is displayed. 

4. Click OK. The connection is deleted. 
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6 Manipulating the Desktop and Selecting 
Text 

PowerTerm WTC enables you to customize the PowerTerm WTC window by 
displaying or hiding desktop components and changing the display colors for 
different text attributes. The color attributes change according to the 
emulation type you have selected. 

This chapter also presents specific text selection techniques that you may 
find useful in different emulations. 

6.1 Manipulating Desktop Components 
Most components are displayed or hidden according to your selection in the 
Options menu. 

 To show/hide the Menu bar: 

1. Select Options | Hide Menu. This conceals the Menu bar. 

2. Click the Control menu or right-click the Title bar. 

3. Select Restore Menu. The Menu bar is shown again. 

Or, 

• Map a Soft button with the following PSL command: 

menu restore 

 To show/hide the Soft buttons: 

• Select Options | Hide Buttons. The menu option becomes Show Buttons. 

• Select again to redisplay the Soft buttons bar. 

 To show/hide the Status bar: 

• Select Options | Hide Status Bar. The menu option becomes Show Status Bar. 

• Select again to redisplay the Status bar. 

 To show/hide the Power Pad: 

• Select Options | Show Power Pad. The menu option becomes Hide Power Pad. 

• Select again to hide the Power Pad. 

 To show/hide the History Scroll bar: 

For non-IBM emulations only. 

1. Select Terminal | Setup. The Terminal Setup dialog appears. 

2. Click the Display tab. The Display property page is displayed. 

3. Select or clear History Scroll Bar in the General section. 

4. Click OK. 
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6.2 Manipulating Desktop Display 
You can customize your desktop display in numerous ways, for example 
change colors of background and/or text, change the cursor display, change 
the work area dimensions, as well as select fonts and GUI language. 

 To change the GUI language: 

• In the Terminal menu, select the desired language. 

6.2.1 Setting Fonts 
PowerTerm WTC enables you to use standard system fonts or select special 
PowerTerm WTC fonts to be displayed in the PowerTerm WTC window. 

• System fonts are standard general-purpose fonts, which different attributes 
can be set. 

• PowerTerm WTC fonts are scaleable fonts, automatically calculated according 
to the screen size of the host application and whether the Unscaled screen 
option is selected or not. 

 To work with PowerTerm WTC fonts: 

Select Terminal | PowerTerm WTC Fonts. The PowerTerm WTC window will 
now display PowerTerm WTC fonts. 

 To work with system fonts: 

1. Select Terminal | System Fonts. The Font dialog appears. 

2. Select the font, style, and size as you desire. 

3. Click OK. The PowerTerm WTC window will now display the selected system 
font. 

 To work with VT soft fonts: 

For VT emulations only. 

The fonts will be loaded from the host application. 

1. Select Terminal | Setup. The Terminal Setup dialog appears. 

2. Click the Display tab. The Display property page is displayed. 

3. Select Enable soft fonts. 

 To lock font size: 

Characters appearing in the work area are scaled and their size will change 
proportionally when changing the desktop size. 

1. Select Terminal | Setup. The Terminal Setup dialog appears. 

2. Click the Display tab for non-IBM emulations and the General tab for IBM 
emulations. 

3. Select Unscaled Screen to lock the font size. 
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 To wrap words at the end of a line: 

For non-IBM emulations only. 

1. Select Terminal | Setup. The Terminal Setup dialog appears. 

2. Click the Display tab. The Display property page is displayed. 

3. Select Autowrap Characters. 

6.2.2 Setting Color 
 To change the display color of the PowerTerm WTC window: 

The color for the Normal attribute determines the color of the entire work 
area. The box above the Select Attribute parameter shows the result of your 
selections. The Select Attribute of the entire screen is generally Normal for 
non-IBM emulations. 

1. Select Terminal | Setup. The Terminal Setup dialog is displayed. 

2. Click the Colors tab. The Color property page is displayed. 

3. Select the attribute for which you want to define foreground and background 
colors. Notice that the attributes change according to the emulation type you 
selected previously. 

4. In the Text area, select the color that you want to apply to the text 
(foreground) of the display. 

5. In the Background area, select the color that you want to apply to the 
background of the text. The preview box above the Select Attribute 
parameter shows the result of your selections. 

6. Click OK. 

 To reverse display colors: 

1. Select Terminal | Setup. The Terminal Setup dialog appears. 

2. Click the Display tab. The Display property page is displayed. 

3. Select Reverse Display Colors. 

 To specify ANSI/Attribute colors: 

For non-IBM emulations only. 

1. Select Terminal | Setup. The Terminal Setup dialog appears. 

2. Click the Colors tab. The Colors property page is displayed. 

3. Select your preference in the Default Colors drop down list. 

6.2.3 Setting work area 
 To specify dimensions of screen: 

1. Select Terminal | Setup. The Terminal Setup dialog appears. 

2. Click the Display tab. The Display property page is displayed. 
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3. Select if you want 80 or 132 Columns or enter your own number of columns 
in Other. 

4. Select how many Lines per screen you want, from the dropdown list. 

5. You can also specify if you want to Limit the font size. 

 To change the appearance of the PowerTerm WTC window: 

1. Select Terminal | Setup. The Terminal Setup dialog appears. 

2. Click the Display tab for non-IBM emulations and the General tab for IBM 
emulations. 

3. Select Power GUI or Show Frame as desired.  

 To specify pace at which data is displayed: 

1. Select Terminal | Setup. The Terminal Setup dialog appears. 

2. Click the Display tab. The Display property page is displayed. 

3. Select if you want Smooth or Jump scrolling. 

4. Select Jump Scroll Speed from the dropdown list. 

 To set tabs in the work area: 

For VT emulations only. 

1. Select Terminal | Setup. The Terminal Setup dialog appears. 

2. Click the Tabs tab. The Tabs property page is displayed. 

3. Click in the ruler where you want to set a tab. A 'T' will appear. 

4. Click the 'T' to clear it. 

5. You can also specify a certain interval between the tabs by entering a 
number and then click Set Every. 

 To set coursor coupling: 

For non-IBM emulations only. 

1. Select Terminal | Setup. The Terminal Setup dialog appears. 

2. Click the General tab. The General property page is displayed. 

3. Select Vertical and/or Page for when the cursor moves past the top or 
bottom border of the user window or to a new page respectively. 

 To display a cursor ruler: 

1. Select Terminal | Setup. The Terminal Setup dialog appears. 

2. Click the Display tab for non-IBM emulations and the General tab for IBM 
emulations. 

3. Select Visible to display the cursor ruler. 

4. Select Crosshair/Horizontal/Vertical appearance of the cursor ruler. 

83 of 127 



  Manipulating the Desktop and Selecting Text 

 To change cursor appearance: 

1. Select Terminal | Setup. The Terminal Setup dialog appears. 

2. Click the Display tab for non-IBM emulations and the General tab for IBM 
emulations. 

3. Select in Cursor the desired appearance. 

4. Select Ins Change to enable toggling the cursor between underline and block 
appearance. 

 To display the status line in the emulation window: 

1. Select Terminal | Setup. The Terminal Setup dialog appears. 

2. Click the General tab. The General property page is displayed. 

3. Select desired option in the Status Line dropdown list. 

 To display the Labels line in the emulation window: 

For ASCII emulations only. 

1. Select Terminal | Setup. The Terminal Setup dialog appears. 

2. Click the General tab. The General property page is displayed. 

3. Select Labels Line. 

 To show host response time: 

For IBM emulations only. 

1. Select Terminal | Setup. The Terminal Setup dialog appears. 

2. Click the General tab. The General property page is displayed. 

3. Select Show Response Time. 

 To disable/enable underlined data: 

If data is transmitted with the underline attribute, you can disable the 
underline by clearing this parameter. 

1. Select Terminal | Setup. The Terminal Setup dialog appears. 

2. Click the Colors tab. The Colors property page is displayed. 

3. Select/Clear Enable Underline as desired. 

 To disable/enable blinking data: 

You can choose whether to enable blinking of data, which was received from 
the host with the blinking attribute. 

1. Select Terminal | Setup. The Terminal Setup dialog appears. 

2. Click the Colors tab. The Colors property page is displayed. 

3. Select/Clear Enable Blink as desired. 

 To set column separator: 

For IBM 5250 emulations only. 
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1. Select Terminal | Setup. The Terminal Setup dialog appears. 

2. Click the Colors tab. The Colors property page is displayed. 

3. Select Column Separator. 

6.3 Selecting Text 
General selection techniques 

 To select a word: 

In the work area, just click a word to select it. 

<Ctrl> + clicking the word will select the word and any punctuation marks 
or other symbols, up to the first space that follows them. 

 If the Automatic Copy option in the Edit menu is active (default), selecting 
text also copies the selection to the clipboard. 

 To select full lines: 

Point to a line, hold down the <Shift> key on the keyboard and drag the 
mouse to the last line you want to include in the selection. 

 To select a string: 

Point to the first character that you want to include in the selection. Drag 
the mouse to the last character that you want to include in the selection and 
release the mouse button. 

 To select the entire screen: 

Select Edit | Select Screen. 

VT emulations' specific techniques 

 To select a block: 

A block is any rectangular section or the work area. 

Point to one corner of the block, hold down the <Ctrl> key on the keyboard 
and drag the mouse to the opposite corner of the block you want to include 
in the selection. 

 To select a menu entry: 

Double-clicking on a word sends that word to the host once you have 
pressed <Enter> on the keyboard. Use this feature to select a menu entry. 
For example, if the emulation screen displays the menu of an application 
residing on the host, click a menu entry to activate the program that the 
menu entry represents. 

IBM emulations' specific techniques 

 To select a block: 

A block is any rectangular section or the work area. 
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Point to one corner of the block and drag the mouse to the opposite corner 
of the block you want to include in the selection. 

 To activate light pen support: 

For IBM 3270 emulations. 

Any double-click on the screen is equivalent to touching the screen with a 
light pen. 
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7 Keyboard Settings 
PowerTerm WTC enables you to map WTC keys to host keys in order to 
emulate the host terminal keyboard. The keyboard mapping definitions are 
stored in a file with the same name as the current terminal setup file, with 
the extension .ptk. For example, the default keyboard mapping definitions 
are stored in a file called ptdef.ptk. 

You can also modify your keyboard to behave in certain ways such as having 
the Backspace key send either backspace or delete, or letting the Numpad 
send a comma. 

7.1 Mapping Keys 
The Keyboard Mapping dialog is presented in three colors: 

• Gray, is a virtual (terminal) key 

• White, is an OS character 

• Yellow, is an OS dead character 

 

 To wiew the keyboard mapping: 

1. Select Options | Keyboard Map. The Keyboard Mapping dialog appears. 

2. Slide the mouse pointer over the different keys. The bottom line of the 
dialog shows you the corresponding WTC and terminal keys. For example, if 
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you point to the "t" key of the VT keyboard, you see that the corresponding 
WTC key is "T". 

 To map a WTC key: 

• Drag a key from the upper terminal keyboard to a WTC key on the lower 
keyboard. 

• Click the <Shift> or <Ctrl> keys on the terminal keyboard to display additional 
key functions. For example, if you click the <Shift> key, the alphabet keys 
on the terminal keyboard are displayed in upper case. You can then map 
(drag) these keys to your WTC keyboard keys. 

 To assign a script command to a WTC key: 

1. Right-click a key on the WTC keyboard that you want to assign a command 
and select Enter Script Commands. The PC Button dialog appears. 

2. Enter the desired script command and click OK. The WTC key has now been 
assigned a script command. 

 To map combinations of keys that include Alt, Ctrl, and Shift: 

• Click the <Alt>, <Ctrl> or <Shift> key (or any combination of them) on your 
WTC keyboard. Then map keys by following the procedure described 
previously. 

• Click the required <Alt>, <Ctrl> or <Shift> key (or any combination of them) 
to view the mapped keys. 

 To cancel a key definition: 

Drag the WTC key definition that you want to cancel to . This restores 
the default function of the WTC key. 

 To replace a WTC key with another WTC key: 

PowerTerm WTC enables you to move the functionality of a mapped WTC 
key to another WTC key. For example, you can drag the F6 key on the WTC 
keyboard to the spacebar on the WTC keyboard to give it F6 functionality. 

• Drag the desired WTC key onto the WTC key that it will replace. The 
functionality of the WTC key has been replaced. 

• Drag the original key back to its initial position to restore the values. 

 To copy a WTC key to another WTC key: 

PowerTerm WTC enables you to copy the functionality of one WTC key to 
another WTC key. 

1. Select the WTC key whose function you want to copy to the required WTC 
key and right-click Copy. 

2. Select the WTC key to where you want to copy the function and right-click 
Paste. Both keys now have the same functionality. 
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 To restore the default keyboard mapping of all mapped keys: 

Click Defaults in the Keyboard Mapping dialog. 

7.2 Saving and Opening Keyboard Mapping Settings 
PowerTerm WTC enables you to save keyboard-mapping settings separately 
and open them at a later date.  

 To save keyboard mapping settings: 

1. Select File | Save Keyboard File. The Save Keyboard File dialog is displayed. 

2. Enter a File Name. 

3. Click Save. 

 To open a predefined keyboard mapping settings: 

1. Select File | Open Keyboard File. The Open Keyboard File dialog is displayed. 

2. Select the required keyboard settings from the list. 

3. Click Open. Parameters defined in the selected keyboard settings are now 
applied to the current session. 

7.3 Keyboard Behavior 
You can customize your keyboard. 

1. Select Terminal | Setup. The Terminal Setup dialog appears. 

2. Click the Keyboard tab. The Keyboard property page is displayed. 

3. Select the behaviors you desire and click OK. 

 To lock alphabet keys in uppercase: 

1. Select Terminal | Setup. The Terminal Setup dialog appears. 

2. Click the Keyboard tab. The Keyboard property page is displayed. 

3. Select Caps (Unix). 

 To lock alphabet and numerick keys in shift setting: 

1. Select Terminal | Setup. The Terminal Setup dialog appears. 

2. Click the Keyboard tab. The Keyboard property page is displayed. 

3. Select Shift. 

 To reverse the Caps Lock: 

1. Select Terminal | Setup. The Terminal Setup dialog appears. 

2. Click the Keyboard tab. The Keyboard property page is displayed. 

3. Select Reverse (Win). Pressing Shift on your keyboard reverses the caps 
operation. 

89 of 127 



  Keyboard Settings 

 To keep Caps Lock mode On: 

You can turn Caps Lock Off in a different application and keep it On in 
PowerTerm WTC. 

1. Select Terminal | Setup. The Terminal Setup dialog appears. 

2. Click the Keyboard tab. The Keyboard property page is displayed. 

3. Select Always On. 

 To set the Backspace key: 

The Backspace key can either send Delete or an actual Backspace. 

1. Select Terminal | Setup and click the Keyboard tab. 

2. Select or clear Backspace Key Sends Delete as you desire and click OK. 

 To automatically repeat a character: 

1. Select Terminal | Setup and click the Keyboard tab. 

2. Select Auto Repeat and click OK. The character will display repeatedly when 
you continuously press its key on the keyboard. 

 To set sounds: 

1. Select Terminal | Setup and click the Keyboard tab. 

2. Select Key Click to issue a click sound when you press a key on the 
keyboard. 

3. Select Warning Bell to issue the terminal's "bell" character (Ascii 7). 

4. Select Margin Bell to issue a bell tone when the cursor reaches the right 
margin. 

5. Click OK. 

 To set the effects of the numeric keypad: 

For VT emulations only. 

1. Select Terminal | Setup and click the General tab. 

2. Select Numeric if you want the keypad to insert numbers. 

3. Select Application if you want to generate control sequences. 

4. Select or clear Numlock to set the NumLock key behavior:  
Cleared, the NumLock behaves as a regular emulation key. It will not change 
the NumLock keyboard status. 
Selected, the NumLock will toggle between function states, enabling either 
numeric keys or arrow keys. 

5. Click OK. 

 To set the numpad decimal: 

The numeric pad's decimal key can send either a decimal or a comma. 

1. Select Terminal | Setup and click the Keyboard tab. 
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2. Select or clear Numpad Decimal Sends Comma as you desire and click OK. 

 To use emulator Alt key: 

Let the <Alt> key perform the terminal operation even if Windows OS has 
an operation mapped to the same key. 

1. Select Terminal | Setup and click the Keyboard tab. 

2. Select Use Emulator Alt Keys and click OK. 

 To display keyboard input: 

Display the keyboard input even if the host system does not echo your 
input. The input will not be displayed if this option is cleared unless the host 
system echoes the characters. 

1. Select Terminal | Setup and click the Keyboard tab. 

2. Select Local Echo and click OK. 

 To set an LK450 Digital keyboard: 

For non-IBM emulations only. 

Change your keyboard to work in Digital VT keyboard mode. 

1. Select Terminal | Setup and click the Keyboard tab. 

2. Select Use VT Keyboard Mode and click OK. 

 To display an answerback message: 

1. Select Terminal | Setup and click the Keyboard tab. 

2. Specify your desired Answerback Message. 

3. Clear to delete the message. 

4. Conceal to hiding the message without erasing it. 

5. Select Auto Answerback to let the terminal automatically send the message 
to the host system. 

6. Click OK. 

 To lock numeric fields: 

For IBM 3270 emulations only. 

Lock the keyboard to avoid entering non-numeric data. 

1. Select Terminal | Setup and click the Keyboard tab. 

2. Select Lock Numeric Fields and click OK. 

 To unlock numeric fields: 

For IBM 3270 emulations only. 

You can enter non-numeric data in numeric fields in two ways. 

1. Select Terminal | Setup and click the Keyboard tab. 
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2. Select Lock Numeric Fields twice so it becomes selected but grayed out. Non-
numeric data can be typed in the field only if <Shift> is pressed at the same 
time. 

3. Clear Lock Numeric Fields. All data can be typed in the field.  

 To type ahead: 

For IBM emulations only. 

Continue to type data before the host responds. 

1. Select Terminal | Setup and click the Keyboard tab. 

2. Select Typeahead and click OK. 

 To set automatic reset: 

Generate a reset key sequence prior to advance to the next field. 

1. Select Terminal | Setup and click the Keyboard tab. 

2. Select Automatic Reset Key and click OK. 

 To set SNA system wait: 

For IBM 3270 emulations only. 

1. Select Terminal | Setup and click the Keyboard tab. 

2. Select Non SNA System Wait and click OK. 
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8 Soft Buttons and Power Pad 
Along the bottom of the PowerTerm WTC window are twelve programmable 
Soft buttons, by default named from F1 to F12. These can be renamed and 
programmed to execute customized scripts or to send individual commands 
to the host. For example, clicking the F1 Soft button is equivalent to sending 
F1 to the host. 

Soft buttons settings are saved automatically in the terminal setup file. 

The Power Pad is a floating keypad that contains buttons, which can be 
programmed to execute customized PSL scripts. You can also change their 
names and adjust the number of buttons displayed in the Power Pad. Power 
Pad buttons are named by default F1, F2, F3 and so on, with a few default 
function names, such as Clear, Enter, and Insert. For example, clicking on the 
F1 button is equivalent to sending F1 to the host. 

Power Pad settings are saved in separate files with the .pad extension. 

 To program Soft buttons: 

1. Right-click the Soft button that you want to program. The Function Button 
dialog is displayed: 

 

2. Enter the Function Description (the new name that will appear on the 
button). 

3. Enter a Script Command, or script commands separated by semicolons. 

4. Click OK. The Soft button is now displayed with its new name. Clicking on it 
will execute the newly defined script command.  

 To program the Power Pad: 

1. Select Options | Show Power Pad or click . The Power Pad is displayed. 

2. Right-click the Power Pad button that you want to program. The Power Pad 
Button dialog is displayed: 
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3. Enter Button Description (the new name that will appear on the Power Pad 
button). 

4. Enter a Script Command, or script commands separated by semicolons. 

5. Click OK. The Power pad button is now displayed with its new name. Clicking 
on it will execute the newly defined script command.  

 To adjust the number of buttons in the Power Pad: 

You can display a maximum of 10 rows and 10 columns in the Power Pad. 
The default number of buttons is 9 rows and 4 columns. 

1. Select Options | Power Pad Setup. The Power Pad Setup dialog is displayed: 

 

2. Click the dropdown list to select the number of rows and columns that you 
want the Power Pad to contain. 

3. Click OK. The Power Pad is displayed with the specified number of rows and 
columns.  

 To save your Power Pad settings: 

1. Select File | Save Power Pad File. The Save Power Pad File dialog is displayed. 

2. Enter a File name and click Save. 

 To open predefined Power Pad settings: 

1. Select File | Open Power Pad File. The Open Power Pad File dialog is displayed.  

2. Select the required Power Pad file and click Open. Parameters defined in the 
selected Power Pad setup are now applied to the current session. 
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9 Printing 
PowerTerm WTC enables you to define print parameters and print the 
terminal screen or data transferred from the host application. 

The Printer property page and Advanced Printing setup dialogs enables you to 
define printing parameters. 

Printing can be done in Text mode or in Graphic mode. For IBM 5250 
printing emulations there is also the option to enable Host printing. 

There are two different modes with different fields enabled: 

• Text mode is designated in the Printer property page by setting the two data 
conversion combo boxes (Print Screen and Slave Printer) to None. 

• Graphics mode is graphic printing. It is designated in the Printer property 
page by setting the two data conversion combo boxes (Print Screen and 
Slave Printer) to Graphics. 

 To define a printer and set printer parameters: 

1. Select File | Print Setup. The Print Setup dialog appears with a set of printing 
parameters. The displayed parameters change according to the printer you 
select. For details, consult your printer documentation. 

2. Specify desired printer parameters and click OK. 

 To define multiple printers: 

1. Select File | Print Setup for Additional Printers | Printer X. The Print Setup dialog 
for that printer appears. 

2. Specify desired printer parameters and click OK. 

 To configure an additional printer for Slave Printing: 

This is accomplished by setting the appropriate properties on both the local 
computer and the central host. 

Local Computer:  

1. Select File | Print Setup for Additional Printer. 

2. Select the desired printer. The desired Printer Setup is displayed. 

3. Make any necessary modifications and click OK. 

Central Host 

You must configure your host to send the appropriate escape sequence 
before sending any output to a slave printer. 

CSI 10 i (open main printer - same as CSI 5 i)  

CSI 11 i (open second printer)  

..  

CSI 15 i (open 6th printer)  
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CSI 4 i close as usual.  

(CSI == esc [ ) 

 To print accumualted data displayed in the work area: 

1. Select File | Start Auto Print. The Start Auto Print command starts 
accumulating incoming data while it is displayed on the screen, and the 
menu option changes to Stop Printing. 

2. Select File | Stop Printing. The Stop Printing command prints all the data 
accumulated in the printing buffer of the slave printer, or in the auto print 
buffer. If data was buffered with a printing request and communication 
failed before the data was sent to the slave printer, select this command to 
print the accumulated data. 

 To manually close the print queue: 

Select File | Close Print Queue. 

 To print the terminal screen: 

1. Mark desired text or the entire contents of the work area. 

2. Select File | Print Screen or click . 

 To define printing parameters: 

1. Select Terminal | Setup. The Terminal Setup dialog appears. 

2. Select the Printer tab. The Printer property page is displayed. 

3. Select the parameters that you require. 

 To define advanced printer parameters: 

Ignore, when selected, applies default values. 

1. Select Terminal | Setup. The Terminal Setup dialog appears. 

2. Select the Printer tab. The Printer property page is displayed. 

3. Click Advanced Printing. The Advanced Printing Setup dialog appears. 

4. Select the parameters that you require.  

 To select a device or network to be the printing output channel: 

 When Graphics is selected for Print Screen Data Conversion/Slave Printer 
Data Conversion, the Print Manager is automatically used as the printing 
output channel with no regards to which Print Device has been selected. 

1. Select Terminal | Setup. The Terminal Setup dialog appears. 

2. Select the Printer tab, and from the Print Device dropdown list select Device 
or Print Manager. 

3. Enter your print communication port in the Device Name field and click OK. 
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 To select a file to be the printing output channel: 

1. Select Terminal | Setup. The Terminal Setup dialog appears. 

2. Select the Printer tab, and from the Print Device dropdown list select File. 

3. Enter your print communication port in the File Name field and click OK. 

 To add a form feed after each printing job: 

1. Select Terminal | Setup. The Terminal Setup dialog appears. 

2. Select the Printer tab, and select Use Form Feed. 

To add a line feed after each carriage return: 

1. Select Terminal | Setup. The Terminal Setup dialog appears. 

2. Select the Printer tab, and select LF->CRLF. 

 To convert line graphic to text: 

1. Select Terminal | Setup. The Terminal Setup dialog appears. 

2. Select the Printer tab, and select Print Line Graphics as Text. 

 To specify the job delimiter character: 

1. Select Terminal | Setup. The Terminal Setup dialog appears. 

2. Select the Printer tab, and select Slave Printer Job Delimiter. 

 To delay print closing: 

1. Select Terminal | Setup. The Terminal Setup dialog appears. 

2. Select the Printer tab, and select Delay for Print Closing. 

 To set values for IBM 5250 (AS/400) host print transform: 

The host sends (ASCII) command and text directly to the printer. 

1. Select Terminal | Setup. The Terminal Setup dialog appears. 

2. Select the Printer property page. 

3. Click Advanced Printing. The Advanced Printer Setup dialog appears. 

4. Select Enable AS/400 Host Print Transform and select the parameters you 
require. 

 To change orientation: 

Default orientation depends on your printer's settings. The options are: 
Ignore, Portrait and Landscape. 

1. Select Terminal | Setup. The Terminal Setup dialog appears. 

2. Select the Printer property page. 

3. Click Advanced Printing. The Advanced Printer Setup dialog appears. 

4. Select desired Orientation in the dropdown list. 
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 To specify printing tray: 

1. Select Terminal | Setup. The Terminal Setup dialog appears. 

2. Select the Printer property page. 

3. Click Advanced Printing. The Advanced Printer Setup dialog appears. 

4. Select desired Tray in the dropdown list. 

 To specify printing margins: 

Printout margins are the space between the edge of the printout page and 
the border of the printing. Margins of the print output can be customized 
according to your specific needs. Modifying the top and left margins will 
determine the position at which printing will begin. 

1. Select Terminal | Setup. The Terminal Setup dialog appears. 

2. Select the Printer property page. 

3. Set the Data Conversion Type to Graphics. 

4. Click Advanced Printing. The Advanced Printer Setup dialog appears. 

5. In the Margins field, type your requirement. For example, to shift the margin 
1 cm type in 100. 

6. Select Auto/Auto (Printer Sizes) for the CPI value to enable the right margin 
field. 

7. Select Auto/Auto (Printer Sizes) for the LPI value to enable the bottom margin 
field. 

 To set an LU/Device name: 

1. Select Terminal | Setup. The Terminal Setup dialog appears. 

2. From the Emulation tab, select either IBM 3270 or 5250 Display, and click OK. 

3. Select Communication | Connect. The Connect dialog appears. 

4. Select your Session Type and enter the IBM Host Name. 

5. In the LU/Device Name field, specify the device name for the emulation 
session. The maximum length of the assigned LU name is 8 characters, 
while that of Device name is 10 characters. 
When using multiple sessions, enter a plus sign (+) after the name (e.g. 
John+) and each session will automatically be assigned a new name (John1, 
John2, etc.). 
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10 Scripts 
PowerTerm WTC enables you to create scripts for automating tasks. For 
example, you can create a script to login to a PowerTerm WTC session, 
execute a file, display a message, etc. Scripts can be run upon startup or 
during a PowerTerm WTC session. They can be written in any standard text 
editor, like Notepad, and are saved with a .psl extension. This chapter 
describes how to create, edit, run, save and activate script in PowerTerm 
WTC. 

The PowerTerm WTC Script Language (PSL) is PowerTerm WTC's own 
programming language. For a full description of the different PSL 
commands, see the "PowerTerm Script Language, Programmer's Reference". 

PowerTerm WTC provides the following script options: 

• Create a Script, creates a script to run upon startup or at any time during a 
PowerTerm WTC session. 

• Edit a Script, edits and modifies an existing script file. 

• Record a Script, creates a script by recording all the actions that you 
perform in the PowerTerm WTC window. Actions can include selecting a 
menu option, typing an entry on the screen, making selections in a dialog, 
and so on. 

• Run Scripts, runs specific scripts or individual commands, upon startup, 
connection to a host, or during a PowerTerm WTC session, to automate 
specific tasks, you can only run saved scripts. 

• Activate a Recorded Script, executes a non-saved script from the current 
memory. 

• Save a Recorded Script, saves your script to be used at a later date. 

• Assign Scripts, to the Power Pad and Soft buttons. 

 To create a script file: 

1. Select Script | Edit Script. The Edit Script dialog appears. 

2. Type a name for the new script in the script Name text box. 

3. Click Edit. The PowerTerm WTC Script Editor appears. 

4. Type the script and select Save from the File menu to save your new script. 
The next time you run or edit a script, this new file will appear in the Scripts 
List. 

5. Select File | Exit to exit the editor. 

 To edit a script file: 

1. Select Script | Edit Script. The Edit Script dialog appears. 

2. Select the required script file and click OK. The PowerTerm WTC Script Editor 
appears. 
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3. Edit the script and click Save from the File menu to save your changes. 

4. Select File | Exit to exit the editor. 

 To record a script: 

1. Select Script | Start Script Recording or click . Your actions start to be 
recorded and the menu option changes to Stop Script Recording. The manual 
operations you perform in the emulation screen are recorded. For example, 
enter parameters in a dialog, or type a password. 

2. Select Script | Pause Script Recording if you do not want to record certain 
operations. The script recording process pauses and the menu option 
changes to Continue Script Recording. 

3. Select Script | Continue Script Recording to resume the recording. 

4. Select Script | Stop Script Recording or click  when you have performed 
all the operations to be stored in the script. You can also save the script that 
you just created, so that you can run it at any time to repeat the operations. 

 To activate a recorded script: 

• Select Script | Activate Recorded Script (<Alt>+<F9>). The script currently 
recorded in memory is now activated. 

 To save a recorded script: 

1. Select Script | Save Recorded Script. The Save Recorded Script dialog appears. 

2. Enter a script name. 

3. Click OK. The script will be saved with the specified name 

 To run a specific script: 

1. Select Script | Run Script. The Run Script dialog, which lists all the saved 
scripts, appears. 

2. Double-click the script that you want to run. The selected script is executed. 

 To run individual script commands: 

1. Select Script | Script Command. The Script Command dialog appears. 

2. Type the name of the script command you want to run. Include parameters 
if necessary. 

3. Click OK. The specified script command is executed at once. 

 To run a script at startup: 

This option creates a Windows shortcut to PowerTerm WTC and a specific 
script file. It can be used to connect to different hosts using different scripts. 

The following procedure describes one way to create a shortcut. Consult 
your Windows documentation for a description of other available options. 

1. Locate the file ptw23.exe on your computer. 
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2. Right-click and select Create Shortcut. The Shortcut to ptw32.exe appears in 
the current folder. 

3. Right-click the created shortcut and select Properties. The Shortcut to 
ptw32.exe Properties dialog appears. 

4. In the Target field, add a space after the .exe file name and then type the 
name of the required script (.psl) file. You can also add parameters to the 
script file. These determine communication parameters, for example the 
name of the host to which you want to connect, or the Port number. 
In the Target field, add a space after the .psl script file and then type the 
required parameters. Parameters should be separated by a space. 
Example: 
\PTW32\PTW32.EXE COMM.PSL 1 9600 xonxoff 
PowerTerm WTC recognizes Windows file naming conventions, including 
spaces in a file name. If you have a setup file with a space in the name, 
PowerTerm WTC ignores the space and looks directly for the .psl extension. 

5. Click OK. When you start PowerTerm WTC, the script file is automatically 
executed and you are connected to the host that you specified in your setup 
file. 

 To run a script file upon connecting to a host: 

1. Open the Connect dialog. 

2. Click the browse button next to Script File in Upon Connection Run. 

3. Select the desired file. 

4. Click OK. The designated script will be executed upon connection. 

 To run a script file during a PowerTerm WTC session using Soft buttons: 

• Click the Soft button that has the desired script assigned. The script is 
executed. For more information, see chapter Soft Buttons and Power Pad. 

 To run a script file during a PowerTerm WTC session using the Power Pad: 

• Click the Power Pad button that has the desired script assigned. The script is 
executed. For more information, see chapter Soft Buttons and Power Pad. 
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11 Session Manager 
PowerTerm WTC standard edition features a Session Manager that provides 
quick access to a list of user-configured sessions. The list includes both 
active and non-active sessions and you can in an easy way determine which 
of the non-active sessions you want to activate. The Session Manager 
enables you to conveniently modify the connection parameters or setup of a 
desired connection. 

Activated sessions are also represented by lettered icons on the toolbar. 
Clicking on it will bring the active session to the foreground. 

 To activate all or some of the sessions: 

1. Select Sessions | Session Manager. The PowerTerm WTC Session Manager 
toolbar appears. 

2. Select the desired session(s) to activate and click Activate Session. The 
selected emulation session is displayed. 

 To modify the connection parameters or setup of a desired connection: 

When modifying connection parameters, the Connection Name cannot be 
modified. 

1. Select the desired connection. 

2. Right-click the appropriate action. 
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12 PowerTerm WTC FTP Client 
The PowerTerm WTC FTP client is a client-server application, which uses the 
File Transfer Protocol (FTP). It provides an easy to use graphic user interface 
to define how to transfer files between your computer (client) and remote 
computers (servers), across a wide variety of platforms like Unix, Windows, 
and more. It does not matter where the two computers are located, how 
they are connected, or whether they use the same operating system. 

PowerTerm WTC FTP client provides direct access to any FTP server site. The 
server site only requires a login identity and password before it responds to 
requests. 

12.1 Features and Benefits 
PowerTerm WTC FTP client 

• Provides access to a wide variety of operating systems, including UNIX, 
Windows 95/98/ME/2000/NT/XP/20003, VAX/VMS, IBM AS400, IBM 
Mainframe operating systems (such as MVS, VSE, etc.) and more. 

• Saves connection parameters in a configuration file. 

• Uses prompt messages to confirm actions. 

• Provides detailed on-screen connection information. 

• Provides a choice of Binary or ASCII data transfer modes. 

• Provides a variety of data conversion options. 

• Creates, removes and changes directories, as well as deletes and renames 
files. 

• Views files in the format that they were created. 

• Automates connection and transfer operations. 

• Provides support for a variety of firewall options. 

12.2 Concepts 
The following concepts are used in this guide: 

FTP Site The remote site to which you are 
connecting. In this guide this 
term is also known as a host or 
remote computer. 

Configuration Settings Contains your PowerTerm WTC 
FTP client preferences and 
selected data transfer mode. 
These parameters only remain 
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active for a current transfer 
session, unless they are saved in 
a configuration file. 

Connection Profile Creates a connection profile for 
an FTP site with which you 
frequently establish 
communication. This profile 
contains login, system, and 
directory and firewall 
information. The connections 
profile, along with configuration 
information, is saved in a 
configuration file. 

Connection List Displays, in the Connection 
dialog, the saved connection 
profiles. 

Configuration File Contains your connection profiles 
and configuration settings. 
Configuration files are saved 
with a .cfg extension. Default 
configuration file is ftp.cfg which 
is loaded at startup. 

Current Session Refers to the current connection 
between your WTC and the 
remote computer. 
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12.3 PowerTerm WTC FTP Client Window 

 

The PowerTerm WTC FTP client window consists of the following components: 

Control Menu Box Provides standard Windows 
commands. 

Title Bar Displays the application name 
and the Configuration File 
currently in use. 

Menu Bar Contains drop-down menus, 
which enables you to access 
PowerTerm WTC FTP client 
functions. 

Toolbar Contains icons, which can be 
used as shortcuts to access 
frequently used menu 
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commands. 

Display Area Displays information about a 
selected file, like file size, date 
and time for compilation etc. 
when you select more than one 
file, the combined size of files is 
shown. The Display Area also 
shows the current button, menu 
or toolbar option selected. When 
you connect to a remote device, 
a message is displayed with the 
name of the host to which you 
are connecting. 

Application Status Icon Displays the activity status of 
PowerTerm WTC FTP client. The 
icon is active while the client is 
running. 

12.3.1 Menu Bar 

File Menu Provides options to create, open, 
and save a configuration file, as 
well as exit the client. 

Settings Menu Provides options to select 
preferences for file transfer and 
define the data translation 
mode. 

Services Menu Provides options to connect and 
display connection information in 
a log window. This menu also 
enables you to refresh the file 
list in both the local and remote 
directory. 

Help Menu Provides online help and product 
information. 

12.3.2 Toolbar 

New 
 

Creates a new configuration file. 

Equivalent to File | New 
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Open 
 

Opens an existing configuration 
file. 

Equivalent to File | Open 

Save 
 

Saves a configuration file. 

Equivalent to File | Save 

Options 
 

Opens the FTP - Preferences 
dialog which enables you to 
select preferences for file 
transfer.  

Equivalent to Settings | Options 

File Transfer 
Setup  

Opens the Data Conversion 
dialog which enables you to 
select options for data 
conversion. 

Equivalent to Settings | File 
Transfer Setup 

Connect 
 

Opens the Connect dialog which 
enables you to enter connection 
parameters for file transfer. 

Equivalent Services | Connect 

Log Windows 
 

Opens the Log – FTP window. 

Equivalent Services | Log 

Refresh 
 

Refreshes the display of 
directories and file names 
shown in the PowerTerm WTC 
FTP client window. 

Equivalent to Services | Refresh 

Exit 
 

Exits the PowerTerm WTC FTP 
client application. 

Equivalent to File | Exit 
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12.4 A Quick Guide through PowerTerm WTC FTP 
Client 

The following workflow is a quick guide for using PowerTerm WTC FTP client. 
This quick guide is intended for users who are familiar with FTP applications. 
You can read a more detailed description on how to work with PowerTerm 
WTC FTP client in the following chapters. 

 

Step 1: Launch PowerTerm WTC FTP client 
1. Select in the PowerTerm WTC window, Communication | Run FTP. The 

PowerTerm WTC FTP Client window opens. 

2. Click Connect. The Connect dialog appears. 

Step 2: Connect to an FTP site 
• To define connection parameters for the current session, enter the required 

parameters in the Connect dialog. 

• To save your connection profile for future sessions, type a profile name in 
the Description field and click Add. The connection profile is displayed in the 
Connection List. 

• To select a connection profile, click on a profile in the Connection List. 

• To connect to the specified FTP site, click Connect. 
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Step 3: Transfer files 
Select Copy or Append in the lower part of the PowerTerm WTC FTP client 
window. 

Downloading files: 

1. Select the files to transfer in the Remote/Files field 

2. Click the left arrow button. 

Uploading files: 

1. Select the files to transfer in the Local/Files field. 

2. Click the right arrow button. 

Step 4: Exit 
1. Click Disconnect. A confirmation message is displayed. 

2. Click OK. 

3. Select File | Exit. 

12.5 Configuration Settings 
To set up your PowerTerm WTC FTP client working environment, you need to 
define PowerTerm WTC FTP client preferences and select the required file 
transfer mode. PowerTerm WTC FTP client also provides an option to select 
the data transfer conversion. You can save your own settings to a 
configuration file so that they can be used in later sessions. 

 The parameters that you define will only remain active for the current 
session, unless you save them. 

12.5.1 Defining PowerTerm WTC FTP Client Preferences 
PowerTerm WTC FTP client provides various options to customize your 
working environment. You can specify which actions will prompt you with a 
confirmation message (e.g. removing a file), and specify the information 
displayed when you connect to an FTP site. 
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Confirm Before Determines the actions which 
display a confirm message: 

Remove Directory, prompts you 
for confirmation before deleting 
directories from you computer or 
the remote FTP site. 

Append to File, prompts you for 
confirmation before appending 
(adding) a file to an existing file 
in your computer or the remote 
FTP site. 

Delete File, prompts you for 
confirmation before deleting a 
file from your computer or the 
remote FTP site. 

Replace File, prompts you for 
confirmation before overwriting 
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a file in your computer or the 
remote FTP site. 

On Connection Determines the connection 
information displayed when you 
connect to an FTP site. 

Open Log Window, opens a 
temporary Log-FTP window, 
which displays the messages 
exchanged by your computer 
and the FTP site while 
connecting. This window enables 
you to monitor the status of the 
current FTP connection. 

Open Log File, saves connection 
details to a file, which you can 
then open and view at a later 
date. 

Clear Log File on Connect, clears 
the log file every time you 
connect to a n FTP site. Only the 
current connection information is 
saved in the log file. 

Include Files List in Log, displays 
a list of remote file in he Log-FTP 
window. To access this option 
select Open Log Window. If you 
want to save this list to the log 
file, select Open Log File. 

General Determines general information 
displayed when you use the 
PowerTerm WTC FTP client. 

Keep Version No. of VMS File 
Names, retains the version 
number of the VMS file names. 

Show File Size, displays the size 
of files in the lower part of the 
PowerTerm WTC FTP client 
window. (To view the size of 
files, you may need to enlarge 
the window.) You can use 
standard windowing Shift and 
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Ctrl keys to select multiple files 
and see the combined size of the 
selected files. 

Save Settings on Exit, 
automatically saves the current 
configuration settings when you 
exit PowerTerm WTC FTP client, 
without prompting you to save 
theses settings. If you do not 
select this option, PowerTerm 
WTC FTP client will always 
prompt you to save the current 
configuration file when you exit 
the application. 

Password for Anonymous Login, 
provides PowerTerm WTC FTP 
client with a specified password 
for anonymous login. Type in 
your e-mail address in the 
Password field. 

 To define PowerTerm WTC FTP client preferences: 

1. Select Settings | Options. The FTP-Preferences dialog appears. 

2. Select the option that you require. 

3. Click OK. 

12.5.2 Selecting a File Transfer Mode 
PowerTerm WTC FTP client distinguishes between transferring Binary data 
and transferring a text (ASCII) file. It is important to select the right transfer 
mode to obtain the correct information, when accessing files on host 
computers. By default, PowerTerm WTC FTP client transfers files in Binary 
mode. 

• In Binary mode, data is copied bit by bit so that the original and the copy are 
identical. This mode is usually appropriate when transferring files between 
computers of the same type. Programs are usually transferred in Binary 
mode, for example, .doc, .bat, .exe, and .dll files. 

• In Ascii mode, data is treated as a set of characters (seven bit plus one bit 
for parity checking). The characters transferred have the same meaning on 
the target computer as they have on the source computer. This mode is 
appropriate for transferring textual data between two different systems, for 
example UNIX and Windows. Text files are usually transferred in ASCII 
mode, for example, file with the .txt extension. 

The following is a list of common file types and their recommended mode of 
transfer: 
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Type of File Mode 

Text (.txt)  Ascii 

Spreadsheet Usually Binary 

Database Usually Binary 

Word Processor Ascii 

Program source code Ascii 

Electronic mail message Ascii 

UNIX shell archives (shar) Ascii 

Compressed files (zip, tar, lzh, 
arc, Binary arj) 

Binary 

Unencoded Ascii 

Executable Binary 

Executable script (bat, etc.) Ascii 

PostScript Usually Ascii 

Hypertext (html) documents Ascii 

Pictures (tiff, jpeg, mpeg) Binary 

Rich Text Format (rtf) Ascii 

 When transferring files between UNIX FTP servers and Windows 
computers, select Binary mode if you are not sure about he kind of file you 
are transferring. 

 To select the data transfer mode: 

Click the Binary/Ascii button. 
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12.5.3 File Transfer Setup Options 
You can setup the Data Conversion mode and Data Type for both your 
computer and the remote computer (host). 

 

 

Data Translation Defines the mode of transferring 
files: no translation, Ascii mode 
translation, and Ascii and binary 
translation. 

Host Data Type Defines the data type for the FTP 
site: 7-bit, 8-bit (DOS-Ascii), 
and 8-bit (Windows-Ansi). 

PC Data Type Defines the data type for your 
device: 7-Bit, 8-Bit (DOS-Ascii), 
and 8-Bit (Windows-Ansi). 

 To select file transfer options: 

1. Select Settings | File Transfer Setup. The Data Conversion dialog appears. 

2. Select the required file transfer setup parameters and click OK. 

12.6 Working with Configuration Files 
A Configuration file consists of the configuration settings you have defined 
and your connection profiles. You can save configuration settings to the 
default ftp.cfg configuration file, create a new configuration file, or save the 
configuration file under a different name. All configuration files are saved 
with a .cfg extension. You can use previously defined configuration settings 
by opening an existing configuration file, or by starting PowerTerm WTC FTP 
client with a customized configuration file. To do this, you should create a 
shortcut and add the name of the configuration file to it. For more 
information about creating a shortcut, see paragraph Automatic File Transfer. 
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 To create a new configuration file: 

Select File | New. A new configuration file called noname.cfg is created in 
which you can specify the parameters that you require. 

 To open an existing configuration file: 

1. Select File | Open. The Open Configuration File dialog appears. 

2. Select the configuration file that you require. 

3. Click Open. The configuration file opens with the settings that you previously 
defined. 

 To save a configuration file: 

1. Define configuration settings and connection profiles as required. 

2. Select File | Save. 
The file is saved without any confirmation prompt, if you have already saved 
the current configuration in a .cfg file. 
The Save File As dialog appears if the current configuration files is 
noname.cfg. 

 To save a file under a different name: 

1. Select File | Save As. The Save File As dialog appears. 

2. Specify a name in the File Name field. 

3. Click Save. The file is saved with a .cfg extension. 

12.7 Defining Connection Parameters 
You can set parameters for connecting to an FTP site. These parameters 
include login, system and directory information. The last parameters that 
you specified in the Connect dialog are kept and displayed when you re-open 
it (excluding the password). 

 The parameters that you define will only remain active for the current 
session, unless you save them. 
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12.7.1 Connection Parameters 

 

 

Login Host Name, the remote computer 
that you want to access. Use the 
host computer's domain name or 
its IP address. 

User Name, the account that you 
want to use to access the remote 
computer. Use anonymous if you 
do not have an account on the 
FTP server or enter your user 
name if you have a personal 
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account on the remote 
computer. 

Password, enter the password 
that you have been assigned for 
personal FTP or enter your 
complete e-mail address for 
anonymous FTP. (The characters 
are displayed as asterisks.) 

Account, optional, may be 
required for personal FTP, in 
addition to your user name and 
password. 

System Port, a number that identifies an 
Internet application. Default port 
is 21. 

Type, the operating system used 
by the remote computer. 
Default type is Auto. 

Directory Optional parameters: 

Local, the local directory to or 
from which you want to transfer 
files. 

Remote, the remote directory to 
or from which you want to 
transfer files. 

Description A name for the connection 
profile. 

Connection List Displays a list of the existing 
connection profiles. 

PASV Mode Specifies that the program will 
work in PASV mode. 

Use Firewall Clear this option to enable the 
Firewall button. 
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12.7.2 Firewall Parameters 

 

 

Host Name The computer that you want to 
act as a security guard prior to 
granting access to a remote 
computer. 

User Name The account of the computer 
that you want to perform the 
security check. 

Password Enter the password that you 
were assigned for the computer 
that performs the security check. 

Port A number that identifies an 
Internet application, which 
performs the security check. 
Default port is 21. 

Type The Firewall type. 
If you do not know which type of 
firewall you have, choose the 
default (the most popular) or 
contact your firewall 
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manufacturer to verify the type. 

 To define connection parameters: 

1. Select Services | Connect or click . The Connect dialog appears. 

2. Specify connection parameters. 

 To specify Firewall parameters: 

1. Open the Connect dialog and select Use Firewall to enable the Firewall 
button. 

2. Click Firewall. The Firewall dialog appears. 

3. Enter required parameters and select a firewall type. 

4. Click OK. 

12.8 Working with Connection Profiles 
If you frequently connect to a specific remote computer, you can create a 
Connection Profile for this computer to use again for other PowerTerm WTC 
FTP client sessions. This profile contains the connection parameters for the 
specific FTP site, for example the host name, user name and password. The 
connection profile you create is displayed in the Connection List, which is 
saved in the current Configuration File along with the configuration settings. 
PowerTerm WTC FTP client enables you to modify, delete, and reset (clear) 
the parameters of a Connection Profile. You can also use Reset to introduce 
new parameters and create a new Connection Profile. 

 To create a profile: 

1. Enter parameters in the Connect dialog. 

2. Type a profile name in the Description field. 

3. Click Add. The profile is created and displayed in the Connection List. 

 To modify a profile: 

1. Select the desired profile from the Connection List. 

2. Modify the parameters as required. 

3. Click Modify. The profile is modified. 

 To delete a profile: 

1. Select the desired profile from the Connection List. 

2. Click Delete. The profile is deleted. 

 To reset (clear) a profile: 

1. Select the desired profile from the Connection List. 

2. Click Reset. Parameters are cleared. 
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12.9 Connecting to an FTP Site 
Once you have defined your connection parameters or selected a connection 
profile, you are ready to connect to an FTP site. After the connection is 
established, the PowerTerm WTC FTP client window displays directories and 
files of the remote computer in the lower part of the window. A log window 
is also displayed if you have selected the Open Log Window option in the FTP 
- Preferences dialog. 

 To connect to an FTP site: 

1. Display the Connect dialog. 

2. Specify connection parameters or select a profile from the Connection List. 

3. Click Connect. 

Or, 

• Double-click a profile in the Connection List. 

12.10 Using the FTP Log Window 
You can open a temporary log window to display messages exchanged 
(connection information) by the PowerTerm WTC FTP client and the remote 
server. You can either automatically display the log window every time that 
you connect to an FTP site, or you can open it for a specific session. 

 

 

Start/Stop Toggles between start/stop 
displaying connection 
information. 

Save Saves the connection 
information in a log file. 

Clear Clears the log window. 
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Close Closes the log window. 

 To automatically display connection information for all sessions: 

1. Select Settings | Options. The FTP-Preferences dialog appears. 

2. Select Open Log Window and click OK. The log window will automatically 
open and display connection information each time you connect to an FTP 
site. 

 To display connection information for a specific session: 

1. Select Services | Log. The Log-FTP window opens with no information. 

2. Click Connect in the PowerTerm WTC FTP client window and enter connection 
parameters. 

3. Click Connect. The log window now displays each step in the connection 
process. 

 To stop/start displaying connection information: 

Click Stop/Start to toggle between stopping and resuming the display. 

 To save the connection information to a log file: 

1. Click Save. The Save As dialog appears. 

2. Select the directory and specify the name of the file to which you want to 
save the connection information. 

3. Click Save. The file is saved with the .log extension. 

 To clear the log window: 

Click Clear. All connection information displayed is cleared. 

 To close the log window: 

Click Close. 

12.11 Working with Local and Remote Directories and 
Files 

The PowerTerm WTC FTP client enables you to manipulate directories and 
files in both your own computer and in the remote computer. It also 
provides options to select, create, and remove directories and files, as well 
as rename and view the contents of a file in the format that it was created. 

 Some FTP sites may restrict access to certain function, for example, 
removing a directory or deleting a file. 

 You can use standard windowing convention like Shift and Ctrl, to select 
multiple files. 

 To select a directory: 

There are several ways to select a directory and display its files. 
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• Select the required directory and click Change. 

• Double-click the required directory. 

• Type the directory name in the Directory field and press Enter on the 
keyboard. 

 To create a directory: 

1. Double-click the required drive. 

2. Type the new directory name in the Directory field and click Create. 

 To remove a directory: 

Select the directory you want to remove and click Remove. 

 To view a file: 

The file will be displayed in the format in which it was created, i.e. a file with 
a .doc extension will be opened in Word, and a file with a .txt extension will 
be opened in Notepad. 

• Select the desired file and click View. 

• Double-click the desired file. 

 To delete a file: 

Select the file you want to delete and click Delete. 

 To rename a file: 

1. Select the desired file and click Rename. The Rename dialog appears. 

2. Type the new file name and extension (if necessary), and click OK. The file 
is displayed in the file list with the new name. 

 To refresh the directory display: 

Select Services | Refresh. All changes that you have made to directories 
and/or files are displayed. 

12.12 Transferring Files 
You can download and upload files between your computer and an FTP site. 
Files can be copied to a directory or appended to an existing file. Most menu 
options and toolbar icons are inactive during the transfer of files however 
you can still perform informative operations. For example view directory and 
file information, and access online help. You can minimize the PowerTerm 
WTC FTP client window while file transfer is in progress. 

 You can use standard windowing conventions like Shift and Ctrl to select 
multiple files. 

 To download a file from an FTP site: 

The name of the file, which is to receive the downloaded file, must be 
specified. If the receiving file does not exist, the PowerTerm WTC FTP client 
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will create it for you. The downloaded file is copied into your directory under 
this file name. If this file already exists, the new file will overwrite it. 

Copying a file: 

1. Select the target local directory. 

2. Select the file to download from the FTP site. 

3. Select Copy. 

4. Click the left arrow. The FTP Transfer dialog graphically displays the progress 
of downloading the selected file. 

Appending a file: 

1. Select the target local file. 

2. Select the file to download from the FTP site. 

3. Select Append. 

4. Click the left arrow. The FTP Transfer dialog graphically displays the progress 
of downloading the selected file. 

 To upload a file to an FTP site: 

Copying a file: 

1. Select the target remote directory. 

2. Select the file to upload from your computer. 

3. Select Copy. 

4. Click the right arrow. The FTP Transfer dialog graphically displays the 
progress of uploading the selected file. 

Appending a file: 

1. Select the target remote file. 

2. Select the file to upload from your computer. 

3. Select Append. 

4. Click the right arrow. The FTP Transfer dialog graphically displays the 
progress of uploading the selected file. 

12.13 Automatic File Transfer 
You can automate connection and transfer options by creating a shortcut 
which specifies the necessary parameters to perform these operations. Once 
you have created the shortcut, you activate it by double-clicking its icon. 
The following parameters can be specified: 

• Connection parameters for connecting to an FTP site. They include the host 
site, user name, and password. 

• File transfer parameters for connecting to an FTP site and transferring files to 
or from your computer. The transfer parameters include the location of the 
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PowerTerm WTC FTP client and the host site, file transfer direction, and file 
path of the local or remote file that you want to receive or send. You can 
also use file transfer conventions to transfer all file, or all files of a single 
type, to and from a directory. 

 IMPORTANT The PowerTerm WTC FTP client uses a set sequence of 
parameters to transfer files. This sequence cannot be modified. 

Example of Connection parameters (P): 

 

 

Example of File Transfer parameters (P): 

 

 

Parameter 1 Host site name 

Parameter 2 User name 

Parameter 3 Password 

Parameter 4 File transfer direction: 

Get for downloading 

Put for uploading 

Parameter 5 File transfer mode: 

Binary 

Ascii 

Parameter 6 Path and name of the local or 
remote file that you want to 
transfer, according to the file 
transfer direction specified in 
parameter 4. 

Parameter 7 Path and name of the local or 
remote file that received the 
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transferred file, according to the 
file transfer direction specified in 
parameter 4. 

 IMPORTANT The PowerTerm WTC FTP client will display an error message 
telling you of any missing parameters. You must enter " " as the password 
parameter rather than leaving it empty. 

 To create a shortcut: 

The following procedure describes one way to create a shortcut. Consult 
your Windows documentation for descriptions of other methods. 

1. Locate the file ftpc32.exe on your computer. It resides in the PowerTerm 
WTC installation folder. 

2. Right-click and select Create Shortcut. The shortcut to ftpc32.exe appears in 
the current folder. 

3. Right-click the shortcut and select Properties. The Shortcut to ftpc32.exe 
Properties dialog appears. 

4. Enter after the Target file path, the required parameters. 

5. Click OK. The next time that you open PowerTerm WTC FTP client, it will 
open with the defined parameters. 

12.13.1 File Transfer Conventions 
You can use wildcards and combinations of them, in parameters 6 and 7 to 
transfer groups of files. The symbols used for wildcards are: 

* Any character combination 

? Any single character 

 To transfer all files with the same extension: 

Type * and the file extension to upload or download all files of this type in a 
directory. 

Example: 

All files with the .cpp extension will be copied to /usr/pub/Ericom 

C:\*.cpp /usr/pub/Ericom/ 

 To transfer all files of one type an save them with a different extension: 

Type * and the extension that you want to give to the transferred files. 

Example: 

All files with the .cpp extension will be copied to the folder /usr/pub/Ericom 
receiving the same name, but with a .txt extension 

C:\*.cpp /usr/pub/Ericom/*.txt 
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 To append all files of one type to a specific file: 

Type the name of the file to which you want to append the transferred files. 

Example: 

All files with the .cpp extension will be appended to the file 
/usr/pub/Ericom/aaa.txt 

C:\*.cpp /usr/pub/Ericom/aaa.txt 

 To transfer a file to another unknown file: 

Type ? for the unknown letter in the file name. 

Example: 

The file aaa.log will be copied to the file /usr/pub/Ericom/babcc.txt 

C:\aaa.log /usr/pub/Ericom/b?b*.txt 

12.14 Disconnecting and Exiting 
Before you exit the PowerTerm WTC FTP client, you need to disconnect from 
the current FTP site. 

Changes to the preferences are either saved automatically when you exit the 
client, if you selected Save Settings on Exit, or you are prompted to save 
them. 

 To disconnect from an FTP site: 

Click Disconnect. 

 To exit the PowerTerm WTC FTP client: 

Select File | Exit. 

12.15 Troubleshooting the PowerTerm WTC FTP 
Client 

If you have any difficulties with PowerTerm WTC FTP client, refer to the 
following checklist: 

Connection cannot be 
established 

• Ensure that the remote system 
provides an FTP server, which is 
running. 

• Ensure you have entered the 
system type correctly. Select 
Auto if you do not know the 
system type to which you are 
connecting. 

PowerTerm WTC FTP client 
reports a login failure 

Ensure that the User name and 
Password were entered correctly. 
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Files cannot be transferred or 
received 

• Ensure that the correct transfer 
type (Binary or Ascii) is selected. 
Transferring a file in the 
incorrect mode may corrupt that 
file. Select Binary, unless you 
transfer text files to or from a 
UNIX FTP server 

• Ensure that you have the 
necessary permission for specific 
operations, like write access to a 
directory. 
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